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 Attention!  Consult accompanying documents prior to use. 
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ÄA Note about Cleaning PRC Products 
 

Prentke Romich products can be cleaned with a warm, damp (not wet) cloth.   
 

To disinfect, mix ¼ cup vinegar with 1 cup water.   
Wipe product with this mixture and allow product to air dry. 
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�Tips for a Successful Windows or DOS Memory 
Transfer 
 
 

�Plug in the battery charger before you begin a memory transfer. 
� �

�DO NOT attempt a memory transfer by using the infrared capability.  Use the cable that 
came with your MTI disks and connect your Pathfinder and computer with the cable. 

�
Â�Have at least 2 or 3 formatted disks ready before you begin the transfer. 
�

Â�Before you begin a transfer with this MTI, remove any older versions of the MTI that you 
may have on your computer  

�

Â�Once the transfer is in progress, do not plug anything into, or unplug anything from, the 
Pathfinder. 

�

Â�When a transfer is in progress, periodically check the computer screen and Pathfinder display 
for any messages or problems. 

�
Â�If you experience a problem, try changing the baud rate to 57600 in the MTI menu bar.  Also, 

double check your port setting.   
 

ÂYou may want to make a backup copy of each individual User Area as well as a backup copy 
of the entire device.  This will prove helpful if you experience technical difficulties with 
your Pathfinder at some other time.   

 

Â Make sure AppleTalk and SerialKeys are turned Off. 
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ÄFor All Pathfinder MTI Transfers 
 
 

ÂVocabulary, Activities and Notebooks are specific to each User Area.  That is, they can only 
be accessed from a specific User Area. 
 

ÂImported icons, graphics and WAV files, the Speech Dictionary, the Word Prediction 
Dictionary, and IR commands are universal to all User Areas.  That is, they can be accessed from 
any User Area. 
 

ÂWhen you save a single User Area, the only imported graphics/icons/WAV files that will be 
saved are those that are used in that specific User Area.  When you save the entire device 
contents, all imported graphics/icons will be saved. 
 

ÂAbout Merging Vocabulary: 
When you load vocabulary from one User Area into the Pathfinder you are asked if you want to 
Erase Old Vocabulary, Merge:  Keep Old if Conflict;  Merge:  Replace Old if Conflict.  If you 
do not want to erase old vocabulary, you must select one of the Merge options.  If the Pathfinder 
encounters conflicts between old and new vocabulary, you can tell the it to Keep the old 
vocabulary (and ignore the new)or to Replace the old vocabulary with the new vocabulary. 
 

ÂThe Speech dictionary and any imported icons and graphics will be merged according to your 
directions.  The Word Prediction Dictionary and any IR commands will not be merged.  You 
will have to re-teach the IR commands to the Pathfinder. 
 

ÂYou cannot save the Word Prediction Dictionary with a single User Area or load it into a 
single User Area.  If you have modified your Word Prediction Dictionary, you should use Save 
Entire Device Contents if you want a backup of the Dictionary.  If you save the entire device 
contents, you cannot load just one User Area from that file back into the Pathfinder.  You have to 
load the whole backup.   
 

ÂWhen you Erase Vocabulary from the MAINTENANCE menu, the Speech and Word 
Prediction Dictionaries return to their default settings.  Imported icons and graphics and any IR 
commands will be deleted. 
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About Baud Rates  
 
When the Pathfinder and a computer are connected, they send information to each other through 
their serial ports.  How fast the information travels from one serial port to the other is called the 
Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The important thing 
is that the baud rate for your computer (or MTI program) and the baud rate for the 
Pathfinder must be the same.   
 
The default baud rate for the Pathfinder is 57600.  You can change the MTI baud rate to match 
the Pathfinder or you change the Pathfinder’s baud rate to match the MTI program. 
 
 

To Change the MTI Baud Rate to Match the Pathfinder: 
 
If you are using DOS, change the MTI program’s baud rate when you boot up the program.  Type 
"dosmti <space>the new baud rate<enter>".  For example:  C:/dosmti 9600 <ENTER>.   
 
For Windows, change the baud rate in the MTI "Options" menu. 
 
 

To Change the Pathfinder’s Baud Rate to Match the MTI: 
 

1. Go to the Toolbox. 
 
2. Activate the TRANSFER MEMORY MENU. 
 
3. Select "More Items". 
 
4. Activate the "MTI Baud Rate" box until you see the baud rate you want to use. 
 
5. Activate OK. 
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Save Vocabulary on an IBM Computer Using the MTI for 
Windows® 
�
ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
begin. 
 
 

To save memory to an IBM computer running Windows or to load memory 
back into the Pathfinder: 
 
1. All memory transfers should be made with the battery charger plugged in.  Connect one 

end of the battery charger that came with your Pathfinder to the connector labeled CHARGER 
on the side of the Pathfinder.  Plug the other end into a wall outlet.   

 

2. All memory transfers should be made with the PF-IBM cable, not the Pathfinder’s infrared 
capability.  Plug one end of this cable into Serial Port 1 on your computer.  Plug the other 
end into the connector on the top of the Pathfinder labeled with the picture of a computer. 

 

3. Turn the computer On and insert the MTI CD disk into the appropriate drive.  Use "Windows 
Explorer" to go to the drive that has the MTI CD disk in it or right click on "My Computer" 
and click on "Explore" to go to the drive that has the MTI CD disk in it. 

 

4. Double click on "MTI.exe".  The MTI screen is visible on your computer monitor. 
 

5. In the MTI "Options" menu, click on the device you are using (e.g., Pathfinder). 
 

1. Go to the Pathfinder’s Toolbox and open the TRANSFER MEMORY MENU. 
 

2. Activate the option you want to use (e.g., "Save Entire Device Contents" or "Save One User 
Area").  If everything is connected correctly, you will see the "Save to Memory File" on your 
computer screen. 
 

3. On your computer, go to the drive/open the folder where you want to save the memory. 
 

9. Type in a name for the new file, (e.g., PFMEM601).  Click on "Save". 
 

10. The transfer could take awhile.  When the transfer is finished, click, "OK". 
 
 

To Restore a File: 
 

1. Select "Load One User Area" or "Load Entire Device contents" from the TRANSFER 
MEMORY MENU. 

 

2. On your computer, select the file you want to restore (e.g., PFMEM601). 
 

3. Click on "Restore" 
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Put the MTI CD on your hard drive and create a desktop shortcut to it: 
 

1. Using "Windows Explorer", go to the drive where you want to place the MTI CD files.  
 
2. Create a new folder and label it "MTI". 
 
3. Go to the drive that contains the MTI CD disk. 
 
4. Right click on "MTI.exe". 
 
5. Left click on "Copy". 
 
6. Go to the drive where you created the new MTI folder.  Right click on the folder. 
 
7. Left click on "Paste". 
 
8. Repeat these steps for the "MTI.hlp" file on the MTI CD disk. 
 

ÂInstead of using "Copy" and "Paste", you can move the MTI CD files at once into the new 
folder if you want.  Click on one of the files in the MTI CD disk, then hold down the SHIFT key 
and click the other MTI CD file.  Release the SHIFT key and drag the highlighted files to your 
new MTI folder.   
 
4. When the files have been moved, double click on the new MTI folder.   
 
10. Right click on "MTI.exe". 
 
11. Left click on "Create Shortcut". 
 
12.  The shortcut icon appears.  Click on it and drag it to your desktop. 
 
13. From now on you can open the MTI by double-clicking on this icon on your desktop. 
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MTI for DOS 
 

ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
start a transfer. 
 

ÂYou can change the MTI program’s baud rate when you boot up the program.  Type "dosmti 
<space>the new baud rate<enter>".  For example:  C:/dosmti 9600 <ENTER> 
 
 
To Save Memory to a Computer Disk or Load it back into the Pathfinder: 
 
1. All memory transfers should be made with the battery charger plugged in.  Connect one 

end of the battery charger that came with your Pathfinder to the connector labeled CHARGER 
on the top of the Pathfinder.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made with the MTI-Serial-PF-to-IBM-PC cable, not the 

device’s infrared capability.  Plug the one end of this cable into Serial Port 1 on your 
computer.  Plug the other end into the connector labeled SERIAL PORT on the top of the 
Pathfinder. 

 
3. Turn the computer On and insert the MTI CD disk into the appropriate drive of your 

computer.  Switch to the drive that has the disk in it if necessary. 

ÂYou may have to start your computer in DOS mode: start the computer, then go to the Start 
menu and click on Shut Down. Click on Restart in DOS mode.  Restart the computer. 

 
4. Type "DOSMTI.exe" and press <RETURN>. 
 
5. Type the letter of the device you are using: in this case type "P". 
 

6. Press the  key on the left front of the Pathfinder case.   
 

7. Activate the TRANSFER MEMORY MENU in the Toolbox.  
 
8. Activate "Save Entire Device Contents" or "Save One User Area" to start the saving process. 
�
ÂUse the "Load" options when you are loading vocabulary into your Pathfinder. Use "Merge" 

when you are adding new vocabulary to your current vocabulary.. 
 
9. On the computer, type in the name of the file you want to save the memory to (e.g., 

PFMEM1).  Press F1 to complete the transfer. 

ÂTo load memory, select the file on the computer that you want to load the memory from. 
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�Tips for a Successful MTI+ Memory Transfer 
(Macintosh) 

 

�Plug in the battery charger before you begin a memory transfer. 
� �

�DO NOT attempt a memory transfer by using the infrared capability.  Use the cable that 
came with your MTI+ disk and connect your Pathfinder and computer with the cable. 

�
ÂThe MTI+ does not work well on the following Macs running a system software version that 
is older than 7.5.3:  Power Mac 6100, 7100 and 8100;  Centris/Quadra 660av and 840av.  You 
can update software from the following internet address:  http://asu.info.apple.com/ 
�
ÂIf you are using a Macintosh that only has a USB port, you will have to purchase a "USB-to-
Serial" adapter.  This will allow your MTI-MAC cable to work with the computer. 
�
Â�If you are using an older Macintosh computer:  turn the computer OFF.  Make your 

connections.  Hold the Shift key down and turn the computer ON.  Continue to hold down 
the Shift key until you see, Welcome to Macintosh, All Extension Off.  Release the Shift key. 

�

ÂIf you want to put the vocabulary on floppy disks, have at least 2 or 3 formatted disks ready 
before you begin the transfer. 
�

ÂIf you have AppleTalk turned On, you must turn it Off (inactive) before you can do a 
memory transfer.  Make sure SerialKeys is Off. 
�

ÂOnce the transfer is in progress, do not plug anything into, or unplug anything from, the 
Pathfinder. 
�

ÂWhen a transfer is in progress, periodically check the computer screen and Pathfinder display 
for any messages or problems. 
�
ÂIf you experience a problem, try changing the baud rate to 57600 in the MTI+ Preferences 
menu (inside the Edit menu). 
 

ÂYou may want to make a backup copy of each individual User Area as well as a backup copy 
of the entire device.  This will prove helpful if you experience technical difficulties with your 
Pathfinder at some other time.   
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About Baud Rates 
 
When the Pathfinder and a computer are connected, they send information to each other through 
their serial ports.  How fast the information travels from one serial port to the other is called the 
Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The important thing 
is that the baud rate for your computer (or MTI program) and the baud rate for the 
Pathfinder must be the same.   
 
The default baud rate for the Pathfinderr is 57600.  You can change the MTI baud rate to match 
the Pathfinder or you change the Pathfinder’s baud rate to match the MTI. 
 
 

To Change the MTI Baud Rate to Match the Pathfinder: 
 

For the MTI+, click the Edit menu on the top of the computer display screen.  Click 
Preferences.  Click on the Baud Rate menu and select the rate you want. 
 
 
To Change the Pathfinder’s Baud Rate to Match the MTI: 
 

Go to the Toolbox. 
 
Activate the TRANSFER MEMORY MENU. 
 
Select "More Items". 
 
Activate the "MTI Baud Rate" box until you see the baud rate you want to use. 
 
Activate OK. 
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Using the MTI+ for Macs 
 
1. All memory transfers should be made with the battery charger plugged in.  Plug the battery 

charger that came with your Pathfinder into the CHARGER connector on the side of the 
Pathfinder.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made using the MTI+ cable that came with your MTI+, not 

the Pathfinder’s infrared capability.  If you are using an older Mac, plug one end of the cable 
into either the connector on the back of the computer that has the picture of the telephone 
handset above it or the picture of a printer.  Plug the other end into the connector that has the 
picture of a computer above it on the top of the Pathfinder.  If you are using a USB Mac, 
plug the cable into the USB port on the computer.  Plug the adapter and the other end of the 
cable into the connector that has the picture of a computer above it on the top of the 
Pathfinder. 

 
3. Turn the computer On and insert the MTI CD.  Double-click on the MTI+ icon to open the 

program. 
 
4. Copy the MTI+ to your Hard Drive for Better Performance: 

 

Click and hold on the folder labeled MTI+.  Drag the folder to a location of your choice on 
your hard drive. 
 

Close any open programs or applications.  Then, double-click on the MTI+ folder on your 
hard drive to open the program.   
 

Making a Transfer 
 

5. Open the EDIT menu at the top of your computer screen and click on Preferences. 
 
6. Make sure Pathfinder is selected in the Device menu. 
 
7. Set the baud rate to the rate you want to use.  The rate that is visible to begin with is the 

default baud rate for your selected device. 
 
8. Select a computer port setting.  If you are using an older Mac, select the port  you connected 

your cable to (either Printer or Modem).  If you are using a USB Mac, the instructions that 
came with your adapter should tell you which port to select.  The Keyspan adapter requires 
you to use the Printer port. 

 
9. Do not change any of the Miscellaneous settings. 
 

10. Activate the  key on the left front of the Pathfinder case.  
 
11. Activate TRANSFER MEMORY MENU. 
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12. Activate "Save Entire Device Contents" or "Save One User Area" to start the saving 
procedure.   

�
ÂUse the "Load" option when you are loading vocabulary into your device.  Use "Merge" if 

you are adding new vocabulary to your current vocabulary.  
 
12. Type in the name of the file you want to use.  
�
Â�To load memory, go to the correct drive (or disk) and double click on the file name you 

want.  Click on "Continue". 
 

ÂIf you experience a problem:  try changing the baud rate to 57600 in the MTI+ Preferences 
menu (inside the Edit menu).  You may have to change the port setting on your computer.  If 
you are not using a USB port, make sure the computer port you selected is the one your cable 
is plugged into, i.e., Modem or Printer.  If you are using the USB port, the Keyspan adapter 
requires you to set the port to Printer.  If you are using a different adapter, the information 
that came with the adapter should tell which computer port to set. 

 

Â�On older Macintoshes you may have to:  turn the computer OFF.  Make your computer-to-
device connections.  Hold the computer Shift key down and turn the computer ON.  
Continue to hold down the Shift key until you see, Welcome to Macintosh, All Extension Off.  
Release the Shift key. 
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Transfer Vocabulary from One Pathfinder to Another 
 
When you plug the MTI-Serial-PF-to-IBM-PC cable into the SERIAL PORT connector on the top 
of each Pathfinder, you can transfer vocabulary from one Pathfinder to another.  If you do not 
have the MTI-IBM cable, you can order it from PRC. 
 
To Transfer Vocabulary from One Pathfinder to Another: 
 

1. Plug the MTI-Serial-PF-to-IBM-PC cable into the SERIAL PORT connector on the back of 
each Pathfinder. (The ends of the cable are the same so it does not matter which end goes 
into which connector.) 

 
2. Go to the Toolbox. 
 
3. Activate the TRANSFER MEMORY on each Pathfinder.  Make sure the baud rate is the same for 

both Pathfinders.   
 
4. On the Pathfinder that contains the vocabulary you want to transfer , activate one of the 

"Save" options to begin the saving procedure. 
 
5. "Looking for host computer...." 
 
6. On the Pathfinder that is going to receive the vocabulary, activate one of the "Load" 

options to start the loading procedure. 
 
5. The transfer takes place automatically.  
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Importing Graphics to the Pathfinder- Windows MTI Only 
 
If you have the Windows MTI, you can import almost any graphic to use in the Pathfinder.  You 
can import photographs that you have scanned, clip art from various web sites, graphics you 
have drawn using a graphics program, etc.   
 

ÂIf you do not have a graphics program on your computer, one is included with the MTI disk.  
This is a demonstration of Image Viewer/32™ and can only be used for a limited amount of time 
(30 days).   
 
 
To import graphics, you need to remember two important rules: 

ÂGraphics must be in the BMP format. 

ÂGraphics must be in 256 colors. 
 
If the MTI will not import a graphic, open a graphics program (either your own or the one 
included with the MTI), open the graphic you want to import and check the file format and 
number of colors for the graphic.  If the graphic is not listed as a BMP file in 256 colors, save it 
using the BMP format and 256 colors. 
 
An Example: 
 

Let’s say you have found a graphic on the web that you want to import to the Pathfinder.   
 
1. Point to the graphic with your mouse and click on the right mouse button.   
 
2. Click on "Save as" in the menu that pops up. 
 
3. Select the drive and/or file where you want to save the graphic. 
 
4. If the graphic is not in "BMP" format, click on "BMP" in the "Save as type" box. (If "BMP" 

is not an option in your menu save the graphic as it is.) 
 
1. Change the title of the graphic if you want. 
 

ÂUse up to 8 characters to name a graphic.   

ÂDo not name your imported graphic with the same name as an original icon from the 
Pathfinder default icons.  You will not be able to find your graphic once it is imported because 
the Pathfinder will only acknowledge the original icon. 
 
6. Click on "Save". 
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You can do one of two things now: 
 

ÂIf you saved the graphic as a "BMP" file: 
You can go ahead and open the MTI and try to import the graphic. See below for instructions.  If 
the graphic was not in 256 colors, the MTI will not let you import it.  
 

ÂIf you could not save the graphic as a BMP file or if you have to check the colors: 
 

1. Open your graphics program.  Open the graphic that you just saved. 
 
2. Open the menu that allows you to select color depth.  In a graphics program like PaintShop 

Pro© this is the "Colors" menu.  In other programs it might be under a different menu. 
 
3. Set the color to 256.  In PaintShop Pro© look at the "Increase Color Depth" and "Decrease 

Color Depth" options.  If "256" is highlighted in either option, select it.  If it isn’t highlighted 
in either menu, the graphic was originally done in 256 colors and will transfer.  

 
4. Go to the "File" menu and click on "Save as".   
 
5. Select the drive and/or file where you want to save the graphic. 
 
6. Select "BMP" from the "Save As Type" menu. 
 
7. Change the title of the graphic if you want. 
 
8. Click on "Save".   
 
 
To Install and Use Image Viewer/32: 
 

1. Put the MTI in the appropriate drive. 
 

2. In the computer Start menu, select Run. 
 

3. Type the drive you have the disk in (e.g.," a: ") 
 

4. Type " ivsetup " (no spaces). 
Example:  a:  ivsetup 
 

5. See the installation screen on your computer. 
 

6. Choose:  
Next 
Agree 
Next 
Next 
Next 
Next 
Finish 
 

 

7. Activate OK.  Activate OK again. 
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8. Go to the Start menu on your computer. 
Select Programs. 
Select Arcata Pet Software. 
Select IMGv3.2 Program File 
Select OK. 
Open the program. 
 

9. Find the photo or icon you want to use. 
 

10. Select Open. 
 

11. You should see your picture. 
 

12. Open the Image menu in the menu bar. 
 

13. Select Convert To and choose 256 colors. 
 

14. Open the File menu in the menu bar. 
 

15. Select Save As. 
 

16. Select BMP. 
 

17. Select Save. 
 
 
To Import the Graphic to the Pathfinder: 
 

1. All memory transfers should be made with the battery charger plugged in.  Connect one 
end of the battery charger that came with your Pathfinder to the connector labeled CHARGER 
on the top of the Pathfinder.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made with the PF-IBM cable, not the Pathfinder’s infrared 

capability.  Plug one end of this cable into Serial Port 1 on your computer.  Plug the other 
end into the connector labeled SERIAL PORT on the top of the Pathfinder. 

 
3. Turn the computer On and insert the MTI-IBM ’95 disk into the appropriate drive.  Use 

"Windows Explorer" to go to the drive that contains the MTI CD disk or right click on "My 
Computer" then click on "Explore" to go to the drive that has the disk in it. 

 
4. Double click on the "MTI-EXE" icon.  The MTI screen is visible on your computer monitor. 
 
5. In the MTI "Options" menu, click on the device you are using (e.g., Pathfinder). 
 
6. Go to the Pathfinder’s Toolbox and open the TRANSFER MEMORY MENU. 
 
7. Activate "Import Icons".  If everything is connected correctly, you will see the "Select one or 

more bitmap files to load" menu on your computer screen. 
 
8. Go to the drive/open the folder where the graphic(s) you want to import is saved. 
 
9. Click on the graphic you want to import.  
10. Click on "Open".   
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11. If you want to change the name of the graphic, do it here.  If you want the graphic to have 
different proportions, remove the "check" from the box. 

 
12. Click "OK". 
 
13. The transfer takes place.  When it is finished, click on "OK".  
 
 
To Check that the Graphic Transferred: 
 

1. Go to the Pathfinder Toolbox. 
 
2. Open the ACTIVITY menu. 
 
3. Select Create Activity. 
 
4. Type "Test" for a name. 
 
5. Activate More Items. 
 
6. You see a new key, "IMPORTS" in the Icon Category menu.  Activate this key. 
 
7. The graphic you imported should be visible and ready for use. 
 
8. Activate Cancel to back your way out of the different ACTIVITY menu. 
 
 

ÂPathfinder places all imported graphics under the IMPORTS key in the Icon Category menu.  
Activate Modify Item in Activity, then activate Change Icon to get to the IMPORTS menu. 
 

ÂTo delete a graphic from the Imports menu:  open the MAINTENANCE menu.  Activate 
Delete Imported Graphic.  Activate the graphic you want to delete.  Answer Yes. Continue to 
delete graphics or Exit the menu. 
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Transferring Notebooks 
 

ÂMake sure the Pathfinder battery charger is plugged in before transferring any Notebooks. 
 
You can save your Notebooks on a disk or transfer text files from your computer to a Pathfinder 
Notebook using the MTI.  You can open the Notebook on your computer and use a word 
processing program to add to/edit the text in your Notebook, if you wish.  When you reload the 
Notebook from your computer into your Pathfinder, the Notebook will contain whatever changes 
you made to it. 
 
To save a Notebook onto a Disk: 
 

1. Connect the cable that came with your MTI to your Computer and your Pathfinder.  Turn 
your computer On and insert the MTI CD.  Open the MTI program. 

 
2. Select Pathfinder from the Options menu. 
 
3. Select the Save to Computer icon on the menu. 
 
4. Activate NOTEBOOK MENU on the Pathfinder. 
 
5. Go to Screen 2 and activate option 6 (Save Notebook to Disk). 
 
6. Open the Notebook you want to save by choosing it from the menu. 
 
7. The Pathfinder will search for the host computer.  If the connections between the Pathfinder 

and your computer are correct, the computer will ask you to type in the name of the file 
(Notebook) you want to save.  Do so, and then continue to follow the instructions on your 
computer screen. 

 
 
Follow the same format for loading a Notebook (or computer file) back into your Pathfinder, 
only this time choose option 5 from the NOTEBOOK MENU.  Follow the prompts on the Pathfinder 
and the computer display screens. 
 

ÄNote:   
 

Notebooks or files in your computer which you want to move to the Pathfinder must be saved on 
the computer in TEXT ONLY format  
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Importing WAV (Sound) Files to the Pathfinder:  Windows 
MTI Only 

 
In order to transfer wav files to your device, you must first have them stored on your computer.  
An easy way to find wav files is to type "wav files" into a search engine on your internet 

browser, then save a few files to a new file on your computer.  ÂThe files you save must be in 
PCM format.  To check this:  right click on the wav file you want, click on "Properties", then 
"Summary" to see the format.  
 

To Transfer a Wav File: 
 

1. All memory transfers should be made with the battery charger plugged in.  Connect one 
end of the battery charger that came with your Pathfinder to the connector labeled CHARGER 
on the side of the Pathfinder.  Plug the other end into a wall outlet.   

 

2. All memory transfers should be made with the PF-IBM cable, not the Pathfinder’s infrared 
capability.  Plug one end of this cable into Serial Port 1 on your computer.  Plug the other 
end into the computer serial port connector on the top of the Pathfinder that is next to the 
Speaker and Earphone connectors. 

 

3. Turn the computer On and insert the MTI CD disk into the appropriate drive.  Use "Windows 
Explorer" to go to the drive that has the MTI CD disk in it or right click on "My Computer" 
and click on "Explore" to go to the drive that has the MTI CD disk in it. 

 

4. Double click on "MTI.exe".  The MTI screen is visible on your computer monitor. 
 

5. In the MTI "Options" menu and click on the name of the device you are using. 
 

6. Go to the Pathfinder’s Toolbox and select the STORE CORE key (you can save wav files using 
any key or menu which allows you to store vocabulary).  . 

 

7. Activate the icon or icons you want to store the wav file under, then activate OK. 
 

8. Select the Recorded option. 
 

9. Select the Import Sound File option. 
 

10. On your computer, go to the drive/open the folder where you have your wav files saved. 
 

11. Select the file you want to import and click on "Open". 
 

12. You will see a Memory Transfer Complete message box when the file has been transferred. 
Click on OK in the message box. You can select Listen to Recording to check that you got 
the correct file.  The wav file is now the recorded message for that icon or icon sequence. 

 

13. Now you can change the icon, the label, the key color, etc., if you wish to. 

ÂIf you have a previously recorded message assigned to a key or sequence and you import a 
wav file, the wav file will replace the recorded message.  Any macros assigned to the key or 
sequence will remain in place.   



 

PATHFINDER 
MTI MANUAL 

25 

Memory Transfers Using a Secure Digital Card Or USB 
Memory Device—Pathfinder Plus Only 
 
The Pathfinder with Plus features allows you to transfer files from the Pathfinder to a computer 
or computer to Pathfinder by using a Secure Digital card or a USB memory device (sometimes 
called a "Keychain" or "Keyfob" device). 
 
Secure Digital Card Transfer 
1. Insert the Secure Digital card in the small slot above the Mouse Serial Port.. Insert the card 

face-up (the side with the writing on it should be face up). Push it in until it stays securely.  
(Push on the end of the card again to remove the card.) 

2. Go to the TOOLBOX and open the TRANSFER MEMORY MENU. 
3. Change the MTI Method option to SD Card.  If the card is securely in place, you will see a 

note telling you Disk Status:  READY and the amount of space available on the card. 

ÂIt may take a few seconds for the Option name to change in the box after you select an up or 
down arrow.  
4. Now select the memory transfer option you want to use and follow the directions you see on 

the display screen. 
5. You will see a message box telling you when the transfer is completed. 
 
USB Transfer 
1. Connect the USB memory device to the rectangular USB port on the left side of the 

Pathfinder case. 
2. Go to the TOOLBOX and open the TRANSFER MEMORY MENU. 
3. Change the MTI Method option to USB Disk.  If the USB device is securely in place, you 

will see a note telling you Disk Status:  READY and the amount of space available on the 
card. 

ÂIt may take a few seconds for the Option name to change in the box after you select an up or 
down arrow.  
4. Now select the memory transfer option you want to use and follow the directions you see on 

the display screen. 
5. You will see a message box telling you when the transfer is completed. 
 

ÂIMPORTANT NOTE 
 

Importing Sound (wav) Files and Saving/Loading Notebooks  
You import sound files while you are in storing menus and you save or load Notebooks while 
you are in the NOTEBOOK MENU.  After connecting your memory device, it is a good idea to go 
first to the MEMORY TRANSFER MENU and select either SD Card or USB Disk.  Then begin the 
storing process for importing sound files or go to the NOTEBOOK MENU to load or save 
Notebooks.   
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�Tips for a Successful Windows or DOS Memory 
Transfer 

 

Plug in the battery charger before you begin a memory transfer. 
� �

DO NOT attempt a memory transfer by using the infrared capability.  Use the VAN/PF 
cable that came with your MTI disks and connect your device and computer with this cable. 
�
ÂIf you are going to save vocabulary to an IBM disk, have at least 2 or 3 formatted disks ready 
before you begin the transfer. 
 

ÂMake sure SerialKeys is turned Off. 

ÂSaving One User Area will not save any changes you may have made to the Word 
Prediction Dictionary and it will not save any IR commands the Vantage or Vanguard II may 
have learned.  You must use Save Entire Device to save IR commands and Word Prediction 
Dictionary changes.   
�

ÂIf you are going to download vocabulary that was programmed for a 15, 8 or 4 location 
overlay, make sure you are currently using the 15, 8 or 4 overlay on your device.  If you aren’t, 
you must open the CHANGE OVERLAY MENU and switch to the 15, 8 or 4 keyboard and overlay 
before you download the vocabulary. 
�

ÂBefore you begin a transfer with this MTI, remove any older versions of the MTI that you 
may have on your computer  
 

ÂOnce the transfer is in progress, do not plug anything into, or unplug anything from, the 
Vantage or Vanguard II. 
�

ÂWhen a transfer is in progress, periodically check the computer screen and device display for 
any messages or problems. 
�
ÂIf you experience a problem, try changing the baud rate to 57600 in the MTI menu bar. 
 



 

VANTAGE/VANGUARD II 
MTI MANUAL 

30 

About Baud Rates  
 
When the Vantage or Vanguard II and a computer are connected, they send information to each 
other through their serial ports.  How fast the information travels from one serial port to the other 
is called the Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The 
important thing is that the baud rate for your computer (or MTI program) and the baud rate 
for the Vantage must be the same.   
 
The default baud rate for the Vantage or Vanguard II is 57600.  You can change the MTI baud 
rate to match your device or you change the device’s baud rate to match the MTI program. 
 
 

To Change the MTI Baud Rate to Match the Vantage or Vanguard II: 
 

If you are using DOS, change the MTI program’s baud rate when you boot up the program.  Type 
"dosmti <space>the new baud rate<enter>".  For example:  C:/dosmti 9600 <ENTER>.   
 
With Windows, change the baud rate in the MTI "Options" menu. 
 
 

To Change the Vantage or Vanguard II Baud Rate to Match the MTI: 
 

1. Go to the Toolbox. 
 
2. Activate the TRANSFER MEMORY MENU. 
 
3. Activate the arrows in the "MTI Baud Rate" boxes until you see the baud rate you want to 

use. 
 
4. Activate OK. 
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Save Vocabulary on an IBM Computer Using the MTI for 
Windows® 
�
ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
begin. 
 
 

To save memory to an IBM computer running Windows or to load memory 
back into the Vantage or Vanguard II: 
 

1. All memory transfers should be made with the battery charger plugged in.  Connect one 

end of the battery charger that came with your device to the connector labeled  on the 
communication device.  Plug the other end into a wall outlet.   

 

2. All memory transfers should be made with the VG-IBM cable, not the infrared capability.  
Plug one end of this cable into Serial Port 1 on your computer.  On the Vantage: plug the 
other end into the connector labeled  on the side of the case.  On the Vanguard II: use the 
connector with the computer icon and the letter A next to it.    

 

3. Turn the computer On and insert the MTI CD into the appropriate drive.  Use "Windows 
Explorer" to go to the drive that has the MTI CD in it or right click on "My Computer" and 
click on "Explore" to go to the drive that has the MTI CD in it. 

 

4. Double click on "MTI.exe".  The MTI screen is visible on your computer monitor. 
 

5. In the MTI "Options" menu, click on the device you are using (e.g., Vantage or Vanguard II). 
 

6. Go to the Toolbox and open the TRANSFER MEMORY MENU. 
 

7. Activate the option you want to use (e.g., "Save Entire Device Contents" or "Save One User 
Area").  If everything is connected correctly, you will see the "Save to Memory File" on your 
computer screen. 

 

8. On your computer, go to the drive/open the folder where you want to save the memory. 
 

9. Type in a name for the new file, (e.g., AMYMEM4-03).  Click on "Save". 
 

10. The transfer could take awhile.  When the transfer is finished, click, "OK". 
 
 

To Restore a File: 
 

1. Select "Load Entire Device" or "Load One User Area" from the TRANSFER MEMORY MENU. 
 

2. On your computer, select the file you want to restore (e.g., VTMEM601). 
 

3. Click on "Restore" 
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Put the MTI on your hard drive and create a desktop shortcut to it: 
 

1. Using "Windows Explorer", go to the drive where you want to place the MTI files.  
 
2. Create a new folder and label it "MTI". 
 
3. Go to the drive that contains the MTI CD. 
 
4. Right click on "MTI.exe". 
 
5. Left click on "Copy". 
 
6. Go to the drive where you created the MTI folder.  Right click on the folder. 
 
7. Left click on "Paste". 
 
8. Repeat these steps for the "MTI.hlp" file on the MTI CD disk. 
 

ÂInstead of using "Copy" and "Paste", you can move the MTI files at once into the new folder 
if you want.  Click on one of the files in the MTI CD disk, then hold down the SHIFT key and 
click the other MTI CD file.  Release the SHIFT key and drag the highlighted files to your 
new MTI folder.   

 
9. When the files have been moved, double click on the new MTI folder.   
 
10. Right click on "MTI.exe". 
 
11. Left click on "Create Shortcut". 
 
12. The shortcut icon appears.  Click on it and drag it to your desktop. 
 
13. From now on you can open the MTI by double-clicking on this icon on your desktop. 
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MTI for DOS 
 

ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
start a transfer. 
 

ÂYou can change the MTI program’s baud rate when you boot up the program.  Type "dosmti 
<space>the new baud rate<enter>".  For example:  C:/dosmti 9600 <ENTER> 
 
To Save Memory to a Computer Disk or Load it back into the Vantage or 
Vanguard II: 
 

1. All memory transfers should be made with the battery charger plugged in.  Connect one 

end of the battery charger that came with your device to the connector labeled .  Plug 
the other end into a wall outlet.   

 

2. All memory transfers should be made with the VG-IBM cable, not the infrared capability.  
Plug one end of this cable into Serial Port 1 on your computer.  On the Vantage: plug the 
other end into the connector labeled  on the side of the case.  On the Vanguard II: use the 
connector with the computer icon and the letter A next to it.    

 

3. Turn the computer On and insert the MTI CD into the appropriate drive.  Switch to the drive 
that has the MTI CD in it if necessary. 

ÂYou may have to start your computer in DOS mode: start the computer, then go to the Start 
menu and click on Shut Down. Click on Restart in DOS mode.  Restart the computer. 

 

4. Type "DOSMTI.exe" and press <RETURN>. 
 

5. Type the letter of the device you are using: in this case the "V" will work with Vantage, 
Vanguard and Vanguard 11. 

 

6. Press the  key on the front of the case.   
You see the Toolbox screen. 
 

7. Activate the TRANSFER MEMORY MENU in the Toolbox.  
 

8. Activate "Save Entire Device Contents" or "Save One User Area" to start the saving process. 
�
ÂUse "Load Entire Device" or "Load One User Area" when you are loading vocabulary into 

your device. Use "Merge" when you are downloading a MAPMate. 
 
9. On the computer, type in the name of the file you want to save the memory to (e.g., 

VGMEM1).  Press F1 to complete the transfer. 

ÂTo load memory, select the file on the computer that you want to load the memory from. 
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�Tips for a Successful MTI+ Memory Transfer 
(Macintosh) 

 

�Plug in the battery charger before you begin a memory transfer. 
� �

�DO NOT attempt a memory transfer by using the infrared capability.  Use the cable that 
came with your MTI+ and connect your Vantage or Vanguard II and computer with this cable. 
�
ÂThe MTI+ does not work well on the following Macs running a system software version that 
is older than 7.5.3:  Power Mac 6100, 7100 and 8100;  Centris/Quadra 660av and 840av.  You 
can update software from the following internet address:  http://asu.info.apple.com/ 
�
ÂIf you are using a Macintosh that only has a USB port, you will have to purchase a "USB-to-
Serial" adapter.  PRC has tested the Vantage and Vanguard II using an adapter made by 
Keyspan.  Check the Keyspan web page or do a search for "USB to Serial Adapters".   
�
ÂIf you want to put the vocabulary on floppy disks, have at least 2 or 3 formatted disks ready 
before you begin the transfer. 
�

ÂIf you have AppleTalk turned On, you must turn it Off (inactive) before you can do a 
memory transfer.  Make sure SerialKeys is Off. 
�

ÂOnce the transfer is in progress, do not plug anything into, or unplug anything from, the 
Vantage. 
�

ÂWhen a transfer is in progress, periodically check the computer screen and device display for 
any messages or problems. 
�
ÂIf you experience a problem:  try changing the baud rate to 57600 in the MTI+ Preferences 
menu (inside the Edit menu).  You may have to change the port setting.  If you are not using a 
USB port, set the port setting to match the port your cable is in (Modem or Printer).  The 
Keyspan adapter requires the port to be set to Printer to work. 
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About Baud Rates 
 
When the Vantage or Vanguard II and a computer are connected, they send information to each 
other through their serial ports.  How fast the information travels from one serial port to the other 
is called the Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The 
important thing is that the baud rate for your computer (or MTI program) and the baud rate 
for the Vantage or Vanguard II must be the same.   
 
The default baud rate for your communication device is 57600.  You can change the MTI baud 
rate to match the device or you change the device’s baud rate to match the computer’s. 
 
 

To Change the MTI Baud Rate to Match the Vantage or Vanguard II: 
 

For the MTI+, click the Edit menu on the top of the computer display screen.  Click 
Preferences.  Click on the Baud Rate menu and select the rate you want. 
 
 
To Change the Vantage or Vanguard II Baud Rate to Match the MTI: 
 

Go to the Toolbox. 
 
Activate the TRANSFER MEMORY MENU. 
 
Activate the arrows in the "MTI Baud Rate" boxes until you see the baud rate you want to use. 
 
Activate OK. 
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Using the MTI+ for Macs 
 
1. All memory transfers should be made with the battery charger plugged in.  Plug the battery 

charger that came with your device into the CHARGER connector on the device.  Plug the 
other end into a wall outlet.   

 
2. All memory transfers should be made using the MTI+ cable that came with your MTI+.  

If you are using an older Mac, plug one end of the cable into the connector on the back of the 
computer that has the picture of the telephone handset above it or the picture of a printer. On 
the Vantage:  plug the other end into connector on the side of the case that has the picture of 
a computer by it.  On the Vanguard II:  plug the other end of the cable into the connector 
that has a computer icon and the letter A next to it.  If you are using a USB adapter, plug the 
adapter with its cable into the USB port on your computer.  Plug the MTI cable into the other 
end of the adapter and then plug it into the connector that has the picture of a computer by it 
on the Vantage or the computer icon with the letter A on the Vanguard II. 

 
3. Turn the computer On and insert the MTI CD.  Double-click on the icon to open the 

program. 
 
4. Copy the MTI+ to your Hard Drive for Better Performance: 

 

Click and hold on the folder labeled MTI+.  Drag the folder to a location of your choice on 
your hard drive. 
 

Close any open programs or applications.  Then, double-click on the MTI+ folder on your 
hard drive to open the program.   

 
5. Open the EDIT menu at the top of your computer screen and click on Preferences. 
 
6. Make sure Vantage or Vanguard II is selected in the Device menu. 
 
7. Set the baud rate to the rate you want to use.  The rate that is visible to begin with is the 

default baud rate for your selected device.   
 
8. Select a Computer Port:  If you are using an older Mac:  select the port you plugged your 

cable into, either Printer or Modem.  If you are using a USB adapter, the adapter must be 
connected to the serial port on the on your device.  On the Vantage this is the connector 
with the picture of the computer by it.  On the Vanguard II this is the connector with the 
computer icon and the letter A beside it.  Select the computer port that your adapter 
instructions tell you to.  If you are using a Keyspan adapter, use the printer port.   

 
9. Do not change any of the miscellaneous settings. 
 

10. Activate the  key on the front of the case.  
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11. Activate TRANSFER MEMORY MENU. 
 
12. Activate one of the Save options to start the saving procedure.   
�
ÂUse the "Load" option when you are loading vocabulary into your device.  You will be asked 

if you want to merge the vocabulary you are loading with your current vocabulary or if you 
want to delete the current vocabulary.  If you select Merge, the device will give precedence 
to the vocabulary you are loading.  If you choose Delete, the vocabulary already in the Area 
will be deleted first, then the new vocabulary loaded.   

 
13. Type in the name of the file you want to use.  
�
Â To load memory, go to the correct drive (or disk) and double click on the file name you 

want.  Click on "Continue". 
 

ÂIf you experience a problem, try changing the baud rate for the computer to 57600 in the 
MTI+ Baud Rate menu under Preferences in the Edit menu on the menu bar.  Remember, 
the baud rate for your device and the computer must be the same.  Also, make sure the 
correct computer port has been used and selected. 

 

Â�On older Macintoshes you may have to:  turn the computer OFF.  Make your computer-to-
device connections.  Hold the computer Shift key down and turn the computer ON.  
Continue to hold down the Shift key until you see, Welcome to Macintosh, All Extension Off.  
Release the Shift key. 
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Transfer Vocabulary from One Device to Another 
 
When you plug the MTI-Serial-VG-to-IBM-PC cable into the SERIAL PORT connector on the 
each Vantage or Vanguard II, you can transfer vocabulary from one device to another.  If you do 
not have the MTI-IBM cable, you can order it from PRC. 
 
To Transfer Vocabulary from One Vantage to Another Vantage or from one Vanguard II 
to another Vanguard II: 
 

1. Plug the MTI-Serial-VG-to-IBM-PC cable into the connector with the picture of a computer 
by it on the side of each Vantage. Use the port with the computer icon and the letter A beside 
it on the Vanguard II.  (The ends of the cable are the same so it does not matter which end 
goes into which connector.) 

 
2. Go to the Toolbox. 
 
3. Activate the TRANSFER MEMORY Menu on each device.  (Make sure the baud rate is the same 

for both each device in the TRANSFER MEMORY MENUs).   
 
4. On the device that contains the vocabulary you want to transfer, activate one of the Save 

options to begin the saving procedure. 
 
5. On the device that is going to receive the vocabulary, activate one of the Load options to 

start the loading procedure. 
 
6. The transfer takes place automatically.  
 

ÂIf you want to transfer specific Activities from one device to another, first load the Activities 
into a blank User Area in the device.  Then save and load that Area. 
 

ÂREMEMBER:  If you save a single User Area, the Vantage or Vanguard II will not 
save any changes you may have made in the Word Prediction Menu, and it will not save any IR 
commands it may have learned.  Use Save Entire Device to save IR commands and Dictionary 
changes. 
 

ÂYou can also transfer an Area or the Entire Device Contents from a 
Vantage to the Vanguard II or vice versa.  Activate the Save as Vanguard (or 
Vantage) option in the TRANSFER MEMORY MENU until On is visible in the box.  Perform a 
regular MTI to a computer disk.  Then use the MTI to load the file from the computer into the 
Vanguard or Vantage.   
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Transferring Notebooks 
 

ÂMake sure the battery charger is plugged in before transferring any Notebooks. 
 
You can save your Notebooks on a disk or transfer text files from your computer to your device 
Notebook using the MTI.  You can open the Notebook on your computer and use a word 
processing program to add to/edit the text in your Notebook, if you wish.  When you reload the 
Notebook from your computer into your device, the Notebook will contain whatever changes 
you made to it. 
 
To save a Notebook onto a Disk: 
 

1. Connect the cable that came with your MTI to your Computer and your device.  Turn your 
computer On and insert the MTI CD.  Open the MTI program. 

 
4. Select your device name from the Options menu. 
 
5. Select the Save to Computer icon on the menu. 
 
4. Activate NOTEBOOK MENU in the TOOLBOX. 
 
5. Activate Save Notebook to Disk. 
 
6. Open the Notebook you want to save by choosing it from the menu. 
 
7. If the connections between your device and your computer are correct, the computer will ask 

you to type in the name of the file (Notebook) you want to save.  Do so, and then continue to 
follow the instructions on your computer screen. 

 
 
Follow the same format for loading a Notebook (or computer file) back into your device, only 
this time choose option 5 from the NOTEBOOK MENU.  Follow the prompts on the device display 
and the computer display screens. 
 

ÄNote:   
 

Notebooks or files in your computer which you want to transfer to your AAC device must be 
saved on the computer in TEXT ONLY format  
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Importing Graphics – Windows® MTI Only 
 
If you have the Windows MTI, you can import almost any graphic to use in the Vantage or 
Vanguard II.  You can import photographs that you have scanned, clip art from various web 
sites, graphics you have drawn using a graphics program, etc.   
 
To import graphics, you need to remember two important rules: 

ÂGraphics must be in the BMP format. 

ÂGraphics must be in 256 colors. 
 
If the MTI will not import a graphic, open your graphics program, open the graphic you want to 
import and check the file format and number of colors for the graphic.  If the graphic is not listed 
as a BMP file in 256 colors, save it using the BMP format and 256 colors. 
 

ÂIf you do not have a graphics program on your computer, one is included on the MTI disk.  
This is a demonstration of Image Viewer/32™ and can only be used for a limited amount of time 
(30 days).   
 
An Example: 
Let’s say you have found a graphic on the web that you want to import to your device.   
 
1. Point to the graphic with your mouse and click on the right mouse button.   
 
2. Click on "Save as" in the menu that pops up. 
 
3. Select the drive and/or file where you want to save the graphic. 
 
4. If the graphic is not in "BMP" form, click on "BMP" in the "Save as type" box. (If "BMP" is 

not an option in your menu save the graphic as it is.) 
 
1. Change the title of the graphic if you want. 
 

ÂUse up to 8 characters to name a graphic.   

ÂDo not name your imported graphic with the same name as an original icon from the Vantage 
or Vanguard II default icons.  You will not be able to find your graphic once it is imported 
because your device will only acknowledge the original icon. 
 
6. Click on "Save". 
 
You can do one of two things now: 
 

ÂIf you saved the graphic as a "BMP" file: 
You can go ahead and open the MTI and try to import the graphic. See below for instructions.  If 
the graphic was not in 256 colors, the MTI will not let you import it.  
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ÂIf you could not save the graphic as a BMP file or if you have to check the colors: 
 

1. Open your graphics program.  Open the graphic that you just saved. 
 
2. Open the menu that allows you to select color depth.  In a graphics program like PaintShop 

Pro© this is the "Colors" menu.  In other programs it might be under a different menu. 
 
3. Set the color to 256.  In PaintShop Pro©, look at the "Increase Color Depth" and "Decrease 

Color Depth" options.  If "256" is highlighted in either option, select it.  If it isn’t highlighted 
in either menu, the graphic was originally done in 256 colors and will transfer.  

 
4. Go to the "File" menu and click on "Save as".   
 
5. Select the drive and/or file where you want to save the graphic. 
 
6. Select "BMP" from the "Save As Type" menu. 
 
7. Change the title of the graphic if you want. 
 
8. Click on "Save".   
 
 
To Install and Use Image Viewer/32: 
 

1. Put the MTI CD in the appropriate drive. 
 

2. In the computer Start menu, select Run. 
 

3. Type the drive you have the disk in (e.g.," a: ") 
 

4. Type " ivsetup " (no spaces). 
Example:  a:  ivsetup 
 

5. See the installation screen on your computer. 
 

6. Choose:  
Next 
Agree 
Next 
Next 
Next 
Next 
Finish 
 

 

7. Activate OK.  Activate OK again. 
 

8. Go to the Start menu on your computer. 
Select Programs. 
Select Arcata Pet Software. 
Select IMGv3.2 Program File 
Select OK. 
Open the program. 
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9. Find the photo or icon you want to use. 
 

10. Select Open. 
 

11. You should see your picture. 
 

12. Open the Image menu in the menu bar. 
 

13. Select Convert To and choose 256 colors. 
 

14. Open the File menu in the menu bar. 
 

15. Select Save As. 
 

16. Select BMP and name the graphic. 
 

17. Select Save. 
 
 
To Import the Graphic to the Vantage or Vanguard II: 
 

1. All memory transfers should be made with the battery charger plugged in.  Connect one 
end of the battery charger that came with your device to the connector labeled CHARGER on 
your device.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made with the VG-IBM cable, not the infrared capability.  

Plug one end of this cable into Serial Port 1 on your computer.  On the Vantage: plug the 
other end into the connector labeled  on the side of the case.  On the Vanguard II: use the 
connector with the computer icon and the letter A next to it.    

 
3. Turn the computer On and insert the MTI CD disk into the appropriate drive of your 

computer.  Use "Windows Explorer" to go to the drive that contains the MTI CD or right 
click on "My Computer" then click on "Explore" to go to the drive that has the disk in it. 

 
4. Double click on the "MTI-EXE" icon.  The MTI screen is visible on your computer monitor. 
 
5. In the MTI "Options" menu, click on the device you are using (e.g., Vantage or Vanguard II). 
 
6. Go to the Toolbox and open the TRANSFER MEMORY MENU. 
 
7. Activate "Import Icons".  If everything is connected correctly, you will see the "Select one or 

more bitmap files to load" menu on your computer screen. 
 
8. Go to the drive/open the folder where the graphic(s) you want to import is saved. 
 
9. Click on the graphic you want to import.  (If you want to import more than one graphic, hold 

down the CONTROL key and click on each graphic that you want to import.) 
 
10. Click on "Open".   
 
11. If you want to change the name of the graphic, do it here.  If you want the graphic to have 

different proportions, remove the "check" from the box. 
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12. Click "OK". 
 
13. The transfer takes place.  When it is finished, click on "OK".  
 
 
To Check that the Graphic Transferred: 
 

1. Go to the Toolbox. 
 
2. Open the MODIFY PAGE MENU. 
 
3. Select any page, e.g., "Jokes". 
 
4. Activate an unused key. 
 
5. Activate "Change Icon". 
 
6. You see a new key, "IMPORTS" in the Icon Category menu.  Activate this key. 
 
7. The graphic you imported should be visible and ready for use. 
 
8. Activate "Cancel" to back your way out of the different MODIFY PAGE menus. 
 
9. If you have graphics that you no longer want in this menu, activate "Delete Icon" and select 

the graphic to be deleted. 
 

ÂAll imported graphics are placed under the IMPORTS key in the Icon Category menu.  
Activate MODIFY ACTIVITY or MODIFY PAGE to access this menu. 
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Importing Wav (Sound) Files:  Windows MTI Only 
 
In order to transfer wav files to your device, you must first have them stored on your computer.  
An easy way to find wav files is to type "wav files" into a search engine on your internet 

browser, then save a few files to a new folder on your computer.  ÂThe files you save must be 
in PCM format.  To check this:  right click on the wav file you want, click on "Properties", then 
"Summary" to see the format.  
 

To Transfer a Wav File: 
 

1. All memory transfers should be made with the battery charger plugged in.  Connect one 
end of the battery charger that came with your Pathfinder to the connector labeled CHARGER 
on the side of the Pathfinder.  Plug the other end into a wall outlet.   

 

2. All memory transfers should be made with the VG-IBM cable, not the infrared capability.  
Plug one end of this cable into Serial Port 1 on your computer.  Plug the other end into the 
computer port (Vantage) or computer port A (Vanguard II). 

 

3. Turn the computer On and insert the MTI CD disk into the appropriate drive.  Use "Windows 
Explorer" to go to the drive that has the MTI CD disk in it or right click on "My Computer" 
and click on "Explore" to go to the drive that has the MTI CD disk in it. 

 

4. Double click on "MTI.exe."  The MTI screen is visible on your computer monitor. 
 

5. In the MTI "Options" menu, click on the name of the device you are using. 
 

4. Go to your device’s Toolbox and select the STORE CORE key (you can save wav files using 
any key or menu which allows you to store vocabulary).  . 

 

5. Activate the icon or icons you want to store the wav file under, then activate OK. 
 

6. Select the Recorded option. 
 

7. Select the Import Sound File option. 
 

8. On your computer, go to the drive/open the folder where you have your wav files saved. 
 

11. Select the file you want to import and click on "Open". 
 

12.You will see a Memory Transfer Complete message box when the file has been transferred. 
Click on OK in the message box. You can select Listen to Recording to check that you got 
the correct file.  The wav file is now the recorded message for that icon or icon sequence. 

 

13. Now you can change the icon, the label, the key color, etc., if you wish to. 
 

ÂIf you have a previously recorded message assigned to a key or sequence and you import a 
wav file, the wav file will replace the recorded message.  Any macros assigned to the key or 
sequence will remain in place.   
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Memory Transfers Using a Secure Digital Card Or USB 
Memory Device—Vantage Plus Only 
 
The Vantage with Plus features allows you to transfer files from the Vantage to a computer or 
computer to Vantage by using a Secure Digital card or by using a USB memory device 
(sometimes called a "Keychain" or "Keyfob" device). 
 
Secure Digital Card Transfer 
6. Open the Memory door on the left side of the Vantage and insert the Secure Digital card in 

the small slot above the system card. Insert the card face-up (the side with the writing on it 
should be face up). Push it in until it stays securely.  (Push on the end of the card again to 
remove the card.) 

7. Go to the TOOLBOX on the Vantage and open the TRANSFER MEMORY MENU. 
8. Change the MTI Method option to SD Card.  If the card is securely in place, you will see a 

note telling you Disk Status:  READY and the amount of space available on the card. 

ÂIt may take a few seconds for the Option name to change in the box after you select an up or 
down arrow.  
9. Now select the memory transfer option you want to use and follow the directions you see on 

the display screen. 
10. You will see a message box telling you when the transfer is completed. 
 
USB Transfer 
1. Connect the USB memory device to the rectangular USB port on the right side of the 

Vantage case. 
2. Go to the TOOLBOX and open the TRANSFER MEMORY MENU. 
3. Change the MTI Method option to USB Disk.  If the USB device is securely in place, you 

will see a note telling you Disk Status:  READY and the amount of space available on the 
card. 

ÂIt may take a few seconds for the Option name to change in the box after you select an up or 
down arrow.  
4. Now select the memory transfer option you want to use and follow the directions you see on 

the display screen. 
5. You will see a message box telling you when the transfer is completed. 
 

ÂIMPORTANT NOTE 
 

Importing Sound (wav) Files and Saving/Loading Notebooks  
You import sound files while you are in storing menus and you save or load Notebooks while 
you are in the NOTEBOOK MENU.  After connecting your memory device, it is a good idea to go 
first to the MEMORY TRANSFER MENU and select either SD Card or USB Disk.  Then begin the 
storing process for importing sound file or go to the NOTEBOOK MENU to save or load 
Notebooks.   
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�Tips for a Successful Windows or DOS Memory 
Transfer 

 

Plug in the battery charger before you begin a memory transfer. 
� �

 Use the MTI cable that came with your MTI and connect your SpringBoard and computer 
with the cable. 
�
ÂIf you are going to save vocabulary to an IBM disk, have at least 2 or 3 formatted disks ready 
before you begin the transfer. 
�

ÂIf you are going to download vocabulary that was programmed for a 15, 8 or 4 location 
overlay, make sure you are currently using the 15, 8 or 4 overlay in the SpringBoard.  If you 
aren’t, you must open the CHANGE OVERLAY MENU and switch to the 15, 8 or 4 keyboard and 
overlay before you download the vocabulary. 
�

ÂBefore you begin a transfer with this MTI, remove any older versions of the MTI that you 
may have on your computer  
 

ÂOnce the transfer is in progress, do not plug anything into, or unplug anything from, the 
SpringBoard. 
�

ÂWhen a transfer is in progress, periodically check the computer screen and SpringBoard 
display for any messages or problems. 
�
ÂIf you experience a problem, try changing the baud rate to 57600 in the MTI menu bar. 
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About Baud Rates  
 
When the SpringBoard and a computer are connected, they send information to each other 
through their serial ports.  How fast the information travels from one serial port to the other is 
called the Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The 
important thing is that the baud rate for your computer (or MTI program) and the baud rate 
for the SpringBoard must be the same.   
 
The default baud rate for the SpringBoard is 57600.  You can change the MTI baud rate to match 
the SpringBoard or you change the SpringBoard’s baud rate to match the MTI program. 
 
 

To Change the MTI Baud Rate to Match the SpringBoard: 
 

If you are using DOS, change the MTI program’s baud rate when you boot up the program.  Type 
"dosmti <space>the new baud rate<enter>".  For example:  C:/dosmti 57600 <ENTER>.   
 
With Windows, change the baud rate in the MTI "Options" menu. 
 
 

To Change the SpringBoard’s Baud Rate to Match the MTI: 
 

1. Go to the Toolbox. 
 
2. Activate the TRANSFER MEMORY MENU. 
 
3. Activate the arrows in the "MTI Baud Rate" boxes until you see the baud rate you want to 

use. 
 
4. Activate OK. 



 

SPRINGBOARD 
MTI MANUAL 

51 

Save Vocabulary on an IBM Computer Using the MTI for 
Windows® 
�
ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
begin. 
 
 

To save memory to an IBM computer running Windows or to load memory 
back into the SpringBoard: 
 

1. All memory transfers should be made with the battery charger plugged in.  Connect one 

end of the battery charger that came with your SpringBoard to the connector labeled  
on the right side of the SpringBoard.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made with the MTI Serial cable that came with your MTI.  

Plug one end of this cable into Serial Port 1 on your computer.  Plug the other end into the 
connector labeled  on the left side of the SpringBoard. 

 
3. Turn the computer On and insert the MTI CD into the appropriate drive.  Use "Windows 

Explorer" to go to the drive that has the MTI CD in it or right click on "My Computer" and 
click on "Explore" to go to the drive that has the MTI CD in it. 

 
4. Double click on "MTI.exe".  The MTI screen is visible on your computer monitor. 
 
5. In the MTI "Options" menu, click on the device you are using (e.g., SpringBoard). 

6. Press the  key on the front of the SpringBoard case.   You see the Toolbox screen. 
 
7. Activate the option you want to use (e.g., "Save Entire Device Contents" or "Save One User 

Area").  If everything is connected correctly, you will see the "Save to Memory File" on your 
computer screen. 

 
8. On your computer, go to the drive/open the folder where you want to save the memory. 
 
9. Type in a name for the new file, (e.g., SBMEM1).  Click on "Save". 
 
10. The transfer could take awhile.  When the transfer is finished, click, "OK". 
 
 

To Restore a File: 
 

1. Select "Load Entire Device" or "Load One User Area" from the TRANSFER MEMORY MENU. 
 

2. On your computer, select the file you want to restore (e.g., VTMEM601). 
 
3. Click on "Restore" 
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Put the MTI on your hard drive and create a desktop shortcut to it: 
 

2. Using "Windows Explorer", go to the drive where you want to place the MTI files.  
 
2. Create a new folder and label it "MTI". 
 
3. Go to the drive that contains the MTI CD. 
 
4. Right click on "MTI.exe". 
 
5. Left click on "Copy". 
 
6. Go to the drive where you created the MTI folder.  Right click on the folder. 
 
7. Left click on "Paste". 
 
8. Repeat these steps for the "MTI.hlp" file on the MTI CD disk. 
 

ÂInstead of using "Copy" and "Paste", you can move the MTI files at once into the new folder 
if you want.  Click on one of the files in the MTI CD disk, then hold down the SHIFT key and 
click the other MTI CD file.  Release the SHIFT key and drag the highlighted files to your 
new MTI folder.   

 
9. When the files have been moved, double click on the new MTI folder.   
 
10. Right click on "MTI.exe". 
 
11. Left click on "Create Shortcut". 
 
12. The shortcut icon appears.  Click on it and drag it to your desktop. 
 
13. From now on you can open the MTI by double-clicking on this icon on your desktop. 
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MTI for DOS 
 

ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
start a transfer. 
 

ÂYou can change the MTI program’s baud rate when you boot up the program.  Type "dosmti 
<space>the new baud rate<enter>".  For example:  C:/dosmti 9600 <ENTER> 
 
 
To Save Memory to a Computer Disk or Load it back into the SpringBoard: 
 
1. All memory transfers should be made with the battery charger plugged in.  Connect one 

end of the battery charger that came with your SpringBoard to the connector labeled  
on the right side of the SpringBoard.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made with the MTI cable that came with your MTI.  Plug 

one end of this cable into Serial Port 1 on your computer.  Plug the other end into the 
connector labeled  on the left side of the SpringBoard. 

 
3. Turn the computer On and insert the MTI CD into the appropriate drive.  Switch to the drive 

that has the MTI CD in it if necessary. 
 
4. Type "DOSMTI.exe" and press <RETURN>. 
 
5. Type the letter of the device you are using: in this case type "V". 
 

6. Press the  key on the front of the SpringBoard case.   
You see the Toolbox screen. 
 

7. Activate the TRANSFER MEMORY MENU in the Toolbox.  
 
8. Activate "Save Entire Device Contents" or "Save One User Area" to start the saving process. 
�
ÂUse "Load Entire Device" or "Load One User Area" when you are loading vocabulary into 

your SpringBoard. Use "Merge" when you are downloading a MAPMate. 
 
9. On the computer, type in the name of the file you want to save the memory to (e.g., 

SBMEM1).  Press F1 to complete the transfer. 

ÂTo load memory, select the file on the computer that you want to load the memory from. 
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�Tips for a Successful MTI+ Memory Transfer 
(Macintosh) 

 

�Plug in the battery charger before you begin a memory transfer. 
� �

�DO NOT attempt a memory transfer by using the infrared capability.  Use the cable that 
came with your MTI+ and connect your SpringBoard and computer with the cable. 
�
ÂThe MTI+ does not work well on the following Macs running a system software version that 
is older than 7.5.3:  Power Mac 6100, 7100 and 8100;  Centris/Quadra 660av and 840av.  You 
can update software from the following internet address:  http://asu.info.apple.com/ 
�
ÂIf you are using a Macintosh that only has a USB port, you will have to purchase a "USB-to-
Serial" adapter.  PRC has tested the SpringBoard using an adapter made by Keyspan.  Check the 
Keyspan web page or do a search for "USB to Serial Adapters".   
�
ÂIf you want to put the vocabulary on floppy disks, have at least 2 or 3 formatted disks ready 
before you begin the transfer. 
�

ÂIf you have AppleTalk turned On, you must turn it Off (inactive) before you can do a 
memory transfer.  Make sure SerialKeys is turned Off. 
�

ÂOnce the transfer is in progress, do not plug anything into, or unplug anything from, the 
SpringBoard. 
�

ÂWhen a transfer is in progress, periodically check the computer screen and SpringBoard 
display for any messages or problems. 
�
ÂIf you experience a problem:  try changing the baud rate to 57600 in the MTI+ Preferences 
menu (inside the Edit menu).  You may have to change the port setting.  If you are not using a 
USB port, set the port setting to match the port your cable is in (Modem or Printer).  The 
Keyspan adapter requires the port to be set to Printer to work. 
 

Â�On older Macintoshes you may have to:  turn the computer OFF.  Make your computer-to-
device connections.  Hold the computer Shift key down and turn the computer ON.  
Continue to hold down the Shift key until you see, Welcome to Macintosh, All Extension Off.  
Release the Shift key. 
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About Baud Rates 
 
When the SpringBoard and a computer are connected, they send information to each other 
through their serial ports.  How fast the information travels from one serial port to the other is 
called the Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The 
important thing is that the baud rate for your computer (or MTI program) and the baud rate 
for the SpringBoard must be the same.   
 
The default baud rate for the SpringBoard is 57600.  You can change the MTI baud rate to match 
the SpringBoard or you change the SpringBoard’s baud rate to match the computer’s. 
 
 

To Change the MTI Baud Rate to Match the SpringBoard: 
 

For the MTI+, click the Edit menu on the top of the computer display screen.  Click 
Preferences.  Click on the Baud Rate menu and select the rate you want. 
 
 
To Change the SpringBoard’s Baud Rate to Match the MTI: 
 

Go to the Toolbox. 
 
Activate the TRANSFER MEMORY MENU. 
 
Activate the arrows in the "MTI Baud Rate" boxes until you see the baud rate you want to use. 
 
Activate OK. 
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Using the MTI+ for Macs 
 
1. All memory transfers should be made with the battery charger plugged in.  Plug the battery 

charger that came with your SpringBoard into the CHARGER connector on the SpringBoard.  
Plug the other end into a wall outlet.   

 
2. All memory transfers should be made using the MTI+ cable that came with your MTI+. 

If you are using an older Mac, plug one end of the cable into the connector on the back of the 
computer that has the picture of the telephone handset above it or the picture of a printer.  If 
you are using a USB adapter, plug the adapter cable into the USB port. Plug the MTI cable 
into the adapter and the other end of the cable into the connector that has the picture of a 
computer by it on the SpringBoard.  

 
3. Turn the computer On and insert the MTI CD.  Double-click on the icon to open the 

program. 
 
4. Copy the MTI+ to your Hard Drive for Better Performance: 

 

Click and hold on the folder labeled MTI+.  Drag the folder to a location of your choice on 
your hard drive. 
 

Close any open programs or applications.  Then, double-click on the MTI+ folder on your 
hard drive to open the program.   

 
5. Open the EDIT menu at the top of your computer screen and click on Preferences. 
 
6. Make sure SpringBoard is selected in the Device menu. 
 
7. Set the baud rate to the rate you want to use.  The rate that is visible to begin with is the 

default baud rate for your selected device.   
 
8. Select a Computer Port:  If you are using an older Mac:  select the port you plugged your 

cable into, either Printer or Modem.  If you have a USB Mac, you cannot currently connect 
to the USB port on the SpringBoard.  You must use a Serial-to-USB adapter.  The adapter 
must be connected to the serial port on the SpringBoard (the connector with the picture of 
the computer by it). Select the computer port that your adapter instructions tell you to.  If 
you are using a Keyspan adapter, use the printer port.   

 
9. Do not change any of the miscellaneous settings. 
 

10. Activate the  key on the front of the SpringBoard case.  
 
11. Activate TRANSFER MEMORY MENU. 
 
12. Activate one of the Save options to start the saving procedure.   
�
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ÂUse the "Load" option when you are loading vocabulary into your device.  You will be asked 
if you want to merge the vocabulary you are loading with your current vocabulary or if you 
want to delete the current vocabulary.  If you select Merge, the SpringBoard will give 
precedence to the vocabulary you are loading.  If you choose Delete, the vocabulary already 
in the Area will be deleted first, then the new vocabulary loaded.   

 
13. Type in the name of the file you want to use.  
�
Â To load memory, go to the correct drive (or disk) and double click on the file name you 

want.  Click on "Continue". 
 

ÂIf you experience a problem, try changing the baud rate for the computer to 57600 in the 
MTI+ Baud Rate menu under Preferences in the Edit menu on the menu bar.  Remember, 
the baud rate for the SpringBoard and the computer must be the same.  Also, make sure the 
correct computer port has been used and selected. 

 

Â�On older Macintoshes you may have to:  turn the computer OFF.  Make your computer-to-
device connections.  Hold the computer Shift key down and turn the computer ON.  
Continue to hold down the Shift key until you see, Welcome to Macintosh, All Extension Off.  
Release the Shift key. 
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Transfer Vocabulary from One SpringBoard to Another 
 
When you plug the MTI-Serial cable into the SERIAL PORT connector on the right side of each 
SpringBoard, you can transfer vocabulary from one SpringBoard to another.  If you do not have 
the MTI-IBM cable, you can order it from PRC. 
 
To Transfer Vocabulary from One SpringBoard to Another: 
 

1. Plug the MTI-Serial-VG-to-IBM-PC cable into the connector with the picture of a computer 
by it on the side of each SpringBoard. (The ends of the cable are the same so it does not 
matter which end goes into which connector.) 

 
2. Go to the Toolbox. 
 
3. Activate the TRANSFER MEMORY Menu on each SpringBoard.  (Make sure the baud rate is 

the same for both SpringBoards in the TRANSFER MEMORY MENUs).   
 
4. On the SpringBoard that contains the vocabulary you want to transfer, activate one of 

the Save options to begin the saving procedure. 
 
5. On the SpringBoard that is going to receive the vocabulary, activate one of the Load 

options to start the loading procedure. 
 
6. The transfer takes place automatically.  
 

ÂIf you want to transfer specific Activities from one device to another, first load the Activities 
into a blank User Area in the device.  Then save and load that Area. 
 

ÂYou can also transfer an Area or the entire device contents to the Vantage.  
Activate the Save as Vantage option in the TRANSFER MEMORY MENU until On is visible in the 
box.  Then perform a regular MTI to a computer disk.  Then use the MTI to load the file from the 
computer into the Vantage.   
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Importing Graphics to the SpringBoard- Windows MTI 
Only 
 
If you have the Windows MTI, you can import almost any graphic to use in the SpringBoard.  
You can import photographs that you have scanned, clip art from various web sites, graphics you 
have drawn using a graphics program, etc.   
 
To import graphics, you need to remember two important rules: 

ÂGraphics must be in the BMP format. 

ÂGraphics must be in 256 colors. 
 
If the MTI will not import a graphic, open your graphics program, open the graphic you want to 
import and check the file format and number of colors for the graphic.  If the graphic is not listed 
as a BMP file in 256 colors, save it using the BMP format and 256 colors. 
 

ÂIf you do not have a graphics program on your computer, one is included on the MTI disk.  
This is a demonstration of Image Viewer/32™ and can only be used for a limited amount of time 
(30 days).   
 
An Example: 
Let’s say you have found a graphic on the web that you want to import to the SpringBoard.   
 
1. Point to the graphic with your mouse and click on the right mouse button.   
 
2. Click on "Save as" in the menu that pops up. 
 
3. Select the drive and/or file where you want to save the graphic. 
 
4. If the graphic is not in "BMP" form, click on "BMP" in the "Save as type" box. (If "BMP" is 

not an option in your menu save the graphic as it is.) 
 
2. Change the title of the graphic if you want. 
 

ÂUse up to 8 characters to name a graphic.   

ÂDo not name your imported graphic with the same name as an original icon from the 
SpringBoard default icons.  You will not be able to find your graphic once it is imported because 
the SpringBoard will only acknowledge the original icon. 
 
6. Click on "Save". 
 
You can do one of two things now: 
 

ÂIf you saved the graphic as a "BMP" file: 
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You can go ahead and open the MTI and try to import the graphic. See below for instructions.  If 
the graphic was not in 256 colors, the MTI will not let you import it.  

ÂIf you could not save the graphic as a BMP file or if you have to check the colors: 
 

1. Open your graphics program.  Open the graphic that you just saved. 
 
2. Open the menu that allows you to select color depth.  In a graphics program like PaintShop 

Pro© this is the "Colors" menu.  In other programs it might be under a different menu. 
 
3. Set the color to 256.  In PaintShop Pro©, look at the "Increase Color Depth" and "Decrease 

Color Depth" options.  If "256" is highlighted in either option, select it.  If it isn’t highlighted 
in either menu, the graphic was originally done in 256 colors and will transfer.  

 
4. Go to the "File" menu and click on "Save as".   
 
5. Select the drive and/or file where you want to save the graphic. 
 
6. Select "BMP" from the "Save As Type" menu. 
 
7. Change the title of the graphic if you want. 
 
8. Click on "Save".   
 
 
To Install and Use Image Viewer/32: 
 

1. Put the MTI CD in the appropriate drive. 
 

2. In the computer Start menu, select Run. 
 

3. Type the drive you have the disk in (e.g.," a: ") 
 

4. Type " ivsetup " (no spaces). 
Example:  a:  ivsetup 
 

5. See the installation screen on your computer. 
 

6. Choose:  
Next 
Agree 
Next 
Next 
Next 
Next 
Finish 
 

 

7. Activate OK.  Activate OK again. 
 

8. Go to the Start menu on your computer. 
Select Programs. 
Select Arcata Pet Software. 
Select IMGv3.2 Program File 
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Select OK. 
Open the program. 
 

9. Find the photo or icon you want to use. 
 

10. Select Open. 
 

11. You should see your picture. 
 

12. Open the Image menu in the menu bar. 
 

13. Select Convert To and choose 256 colors. 
 

14. Open the File menu in the menu bar. 
 

15. Select Save As. 
 

16. Select BMP and name the graphic. 
 

17. Select Save. 
 
 
To Import the Graphic to the SpringBoard: 
 

1. All memory transfers should be made with the battery charger plugged in.  Connect one 
end of the battery charger that came with your SpringBoard to the connector labeled 
CHARGER on the top of the SpringBoard.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made with the IBM cable, not the SpringBoard’s infrared 

capability.  Plug one end of this cable into Serial Port 1 on your computer.  Plug the other 
end into the connector labeled SERIAL PORT (picture of a computer by it) on the side of the 
SpringBoard. 

 
3. Turn the computer On and insert the MTI CD disk into the appropriate drive of your 

computer.  Use "Windows Explorer" to go to the drive that contains the MTI CD or right 
click on "My Computer" then click on "Explore" to go to the drive that has the disk in it. 

 
4. Double click on the "MTI-EXE" icon.  The MTI screen is visible on your computer monitor. 
 
5. In the MTI "Options" menu, click on the device you are using (e.g., SpringBoard). 
 
6. Go to the SpringBoard’s Toolbox and open the TRANSFER MEMORY MENU. 
 
7. Activate "Import Icons".  If everything is connected correctly, you will see the "Select one or 

more bitmap files to load" menu on your computer screen. 
 
8. Go to the drive/open the folder where the graphic(s) you want to import is saved. 
 
9. Click on the graphic you want to import.  (If you want to import more than one graphic, hold 

down the CONTROL key and click on each graphic that you want to import.) 
 
10. Click on "Open".   
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11. If you want to change the name of the graphic, do it here.  If you want the graphic to have 
different proportions, remove the "check" from the box. 

 
12. Click "OK". 
 
13. The transfer takes place.  When it is finished, click on "OK".  
 
 
To Check that the Graphic Transferred: 
 

1. Go to the SpringBoard Toolbox. 
 
2. Open the MODIFY PAGE MENU. 
 
3. Select any page, e.g., "Jokes". 
 
4. Activate an unused key. 
 
5. Activate "Change Icon". 
 
6. You see a new key, "IMPORTS" in the Icon Category menu.  Activate this key. 
 
7. The graphic you imported should be visible and ready for use. 
 
8. Activate "Cancel" to back your way out of the different MODIFY PAGE menus. 
 
9. If you have graphics that you no longer want in this menu, activate "Delete Icon" and select 

the icon to be deleted. 
 

ÂSpringBoard places all imported graphics under the IMPORTS key in the Icon Category menu.  
Activate MODIFY ACTIVITY or MODIFY PAGE to access this menu. 
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Importing Wav (Sound) Files:  Windows MTI Only 
 
In order to transfer wav files to your device, you must first have them stored on your computer.  
An easy way to find wav files is to type "wav files" into a search engine on your internet 

browser, then save a few files to a new folder on your computer.  ÂThe files you save must be 
in PCM format.  To check this:  right click on the wav file you want, click on "Properties", then 
"Summary" to see the format.  
 

To Transfer a Wav File: 
 

1. All memory transfers should be made with the battery charger plugged in.  Connect one 
end of the battery charger that came with your Pathfinder to the connector labeled CHARGER 
on the side of the Pathfinder.  Plug the other end into a wall outlet.   

 

2. All memory transfers should be made with the -IBM cable, not the SpringBoard’s infrared 
capability.  Plug one end of this cable into Serial Port 1 on your computer.  Plug the other 
end into the computer port on the side of the SpringBoard. 

 

3. Turn the computer On and insert the MTI CD disk into the appropriate drive.  Use "Windows 
Explorer" to go to the drive that has the MTI CD disk in it or right click on "My Computer" 
and click on "Explore" to go to the drive that has the MTI CD disk in it. 

 

4. Double click on "MTI.exe."  The MTI screen is visible on your computer monitor. 
 

5. In the MTI "Options" menu, click on the device you are using (e.g., SpringBoard). 
 

6. Go to your device’s Toolbox and select the STORE CORE key (you can save wav files using 
any key or menu which allows you to store vocabulary).  . 

 

7. Activate the icon or icons you want to store the wav file under, then activate OK. 
 

8. Select the Recorded option. 
 

9. Select the Import Sound File option. 
 

10. On your computer, go to the drive/open the folder where you have your wav files saved. 
 

11. Select the file you want to import and click on "Open". 
 

12. You will see a Memory Transfer Complete message box when the file has been transferred. 
Click on OK in the message box. You can select Listen to Recording to check that you got 
the correct file.  The wav file is now the recorded message for that icon or icon sequence. 

 

13. Now you can change the icon, the label, the key color, etc., if you wish to. 
 

ÂIf you have a previously recorded message assigned to a key or sequence and you import a 
wav file, the wav file will replace the recorded message.  Any macros assigned to the key or 
sequence will remain in place.   
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Memory Transfers Using a Secure Digital Card Or USB 
Memory Device 
 
 
The SpringBoard with Plus features allows you to transfer files from the Springboard to a 
computer or computer to SpringBoard by using a Secure Digital card or by using a USB memory 
device (sometimes called a "Keychain" or "Keyfob" device). 
 
Secure Digital Card Transfer 
11. Open the Memory door on the left side of the SpringBoard and insert the Secure Digital card 

in the small slot above the system card. Insert the card face-up (the side with the writing on it 
should be face up). Push it in until it stays securely.  (Push on the end of the card again to 
remove the card.) 

12. Go to the TOOLBOX on the SpringBoard and open the TRANSFER MEMORY MENU. 
13. Change the MTI Method option to SD Card.  If the card is securely in place, you will see a 

note telling you Disk Status:  READY and the amount of space available on the card. 

ÂIt may take a few seconds for the Option name to change in the box after you select an up or 
down arrow.  
14. Now select the memory transfer option you want to use and follow the directions you see on 

the display screen. 
15. You will see a message box telling you when the transfer is completed. 
 
USB Transfer 
1. Connect the USB memory device to the rectangular USB port on the right side of the 

SpringBoard case. 
2. Go to the TOOLBOX and open the TRANSFER MEMORY MENU. 
3. Change the MTI Method option to USB Disk.  If the USB device is securely in place, you 

will see a note telling you Disk Status:  READY and the amount of space available on the 
card. 

ÂIt may take a few seconds for the Option name to change in the box after you select an up or 
down arrow.  
4. Now select the memory transfer option you want to use and follow the directions you see on 

the display screen. 
5. You will see a message box telling you when the transfer is completed. 
 

ÂIMPORTANT NOTE 
 

Importing Sound (wav) Files and Saving/Loading Notebooks  
You import sound files while you are in storing menus and you save or load Notebooks while 
you are in the NOTEBOOK MENU.  After connecting your memory device, it is a good idea to go 
first to the MEMORY TRANSFER MENU and select either SD Card or USB Disk.  Then begin the 
storing process for importing sound file or go to the NOTEBOOK MENU to save or load 
Notebooks.   
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�Tips for a Successful Windows or DOS Memory 
Transfer 

 

�Plug in the battery charger before you begin a memory transfer.. 
� �

�DO NOT attempt a memory transfer by using the infrared capability.  Use the VG cable 
that came with your MTI disks and connect your Vanguard and computer with the cable. 

�
Â�If you are going to save vocabulary to an IBM disk, have at least 2 or 3 formatted disks 

ready before you begin the transfer. 
�

Â�If you are going to download vocabulary that was programmed for an 8 or 4 location 
overlay, make sure you are currently using the 8 or 4 overlay in the Vanguard.  If you aren’t, 
you must open the CHANGE OVERLAY MENU and switch to the 8 or 4 keyboard and overlay 
before you download the vocabulary. 

�

Â�Before you begin a transfer with this MTI, remove any older versions of the MTI that you 
may have on your computer  

�

Â�If you are using a Macintosh computer with AppleTalk turned On, you must turn it Off 
(inactive) before you can do a memory transfer.  Make sure SerialKeys is Off. 

�

Â�Once the transfer is in progress, do not plug anything into, or unplug anything from, the 
Vanguard. 

�

Â�When a transfer is in progress, periodically check the computer screen and Vanguard display 
for any messages or problems. 

�
Â�If you experience a problem, try changing the baud rate to 57600 in the MTI menu bar.  

Double check that you have selected the computer port that your cable is plugged into. 
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About Baud Rates  
 
When the Vanguard and a computer are connected, they send information to each other through 
their serial ports.  How fast the information travels from one serial port to the other is called the 
Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The important thing 
is that the baud rate for your computer (or MTI program) and the baud rate for the 
Vanguard must be the same.   
 
The default baud rate for the Vanguard II is 57600.  You can change the MTI baud rate to match 
the Vanguard or you change the Vanguard’s baud rate to match the MTI program. 
 
 

To Change the MTI Baud Rate to Match the Vanguard: 
 

If you are using DOS, change the MTI program’s baud rate when you boot up the program.  Type 
"dosmti <space>the new baud rate<enter>".  For example:  C:/dosmti 9600 <ENTER>.   
 
For Windows, change the baud rate in the MTI "Options" menu. 
 
 

To Change the Vanguard’s Baud Rate to Match the MTI: 
 

1. Go to the Toolbox. 
 
2. Activate the TRANSFER MEMORY MENU. 
 
3. Activate the arrows in the "MTI Baud Rate" boxes until you see the baud rate you want to 

use. 
 
2. Activate OK. 
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Save Vocabulary on an IBM Computer Using the MTI for 
Windows® 
�
ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
begin. 
 
 

To save memory to an IBM computer running Windows or to load memory 
back into the Vanguard: 
 
1. All memory transfers should be made with the battery charger plugged in.  Connect one 

end of the battery charger that came with your Vanguard to the connector labeled CHARGER 
on the top of the Vanguard.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made with the VG-IBM cable, not the Vanguard’s infrared 

capability.  Plug one end of this cable into Serial Port 1 on your computer.  Plug the other 
end into the connector labeled SERIAL PORT on the top of the Vanguard. 

 
3. Turn the computer On and insert the MTI CD disk into the appropriate drive.  Use "Windows 

Explorer" to go to the drive that has the MTI CD disk in it or right click on "My Computer" 
and click on "Explore" to go to the drive that has the MTI CD disk in it. 

 
4. Double click on "MTI.exe".  The MTI screen is visible on your computer monitor. 
 
5. In the MTI "Options" menu, click on the device you are using (e.g., Vanguard). 
 
6. Go to the Vanguard’s Toolbox and open the TRANSFER MEMORY MENU. 
 
7. Activate the option you want to use (e.g., "Save Entire Device Contents" or "Save One User 

Area").  If everything is connected correctly, you will see the "Save to Memory File" on your 
computer screen. 
 

8. On your computer, go to the drive/open the folder where you want to save the memory. 
 
9. Type in a name for the new file, (e.g., VGMEM601).  Click on "Save". 
 
10. The transfer could take awhile.  When the transfer is finished, click, "OK". 
 
 

To Restore a File: 
 

1. Select "Load Entire Device" or "Load One User Area" from the TRANSFER MEMORY MENU. 
 

2. On your computer, select the file you want to restore (e.g., VGMEM698). 
 
3. Click on "Restore". 
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Put the MTI CD on your hard drive and create a desktop shortcut to it: 
 

3. Using "Windows Explorer", go to the drive where you want to place the MTI CD files.  
 
2. Create a new folder and label it "MTI". 
 
3. Go to the drive that contains the MTI CD disk. 
 
4. Right click on "MTI.exe". 
 
5. Left click on "Copy". 
 
6. Go to the drive where you created the new MTI folder.  Right click on the folder. 
 
7. Left click on "Paste". 
 
8. Repeat these steps for the "MTI.hlp" file on the MTI CD disk. 
 

ÂInstead of using "Copy" and "Paste", you can move the MTI CD files at once into the new 
folder if you want.  Click on one of the files in the MTI CD disk, then hold down the SHIFT 
key and click the other MTI CD file.  Release the SHIFT key and drag the highlighted files to 
your new MTI folder.   

 
9. When the files have been moved, double click on the new MTI folder.   
 
10. Right click on "MTI.exe". 
 
11. Left click on "Create Shortcut". 
 
12. The shortcut icon appears.  Click on it and drag it to your desktop. 
 
13. From now on you can open the MTI by double-clicking on this icon on your desktop. 
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MTI for DOS 
 

ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
start a transfer. 
 

ÂYou can change the MTI program’s baud rate when you boot up the program.  Type "dosmti 
<space>the new baud rate<enter>".  For example:  C:/dosmti 9600 <ENTER>   Remember the 
MTI baud rate and the Vanguard baud rate must be the same. 
 
 
To Save Memory to a Computer Disk or Load it back into the Vanguard: 
 
1. All memory transfers should be made with the battery charger plugged in.  Connect one 

end of the battery charger that came with your Vanguard to the connector labeled CHARGER 
on the top of the Vanguard.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made with the MTI-Serial-VG-to-IBM-PC cable, not the 

device’s infrared capability.  Plug the one end of this cable into Serial Port 1 on your 
computer.  Plug the other end into the connector labeled SERIAL PORT on the top of the 
Vanguard. 

 
3. Turn the computer On and insert the MTI CD into the appropriate drive.  Switch to the drive 

that has the disk in it if necessary. 
 
4. Type "DOSMTI.exe" and press <RETURN>. 
 
5. Type the letter of the device you are using: in this case type "V". 
 

6. Press the  key on the right front of the Vanguard case.   
You see the Toolbox screen. 
 

7. Activate the TRANSFER MEMORY MENU in the Toolbox.  
 
8. Activate "Save Entire Device Contents" or "Save One User Area" to start the saving process. 
�
ÂUse "Load Entire Device" or "Load One User Area" when you are loading vocabulary into 

your Vanguard. Use "Merge" when you are downloading a MAPMate. 
 
9. On the computer, type in the name of the file you want to save the memory to (e.g., 

VGMEM1).  Press F1 to complete the transfer. 

ÂTo load memory, select the file on the computer that you want to load the memory from. 
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�Tips for a Successful MTI+ Memory Transfer 
(Macintosh) 
 

�Plug in the battery charger before you begin a memory transfer. 

�DO NOT attempt a memory transfer by using the infrared capability.  Use the cable that 
came with your MTI+ disk and connect your Vanguard and computer with the cable. 
�
ÂThe MTI+ does not work well on the following Macs running a system software version that 
is older than 7.5.3:  Power Mac 6100, 7100 and 8100;  Centris/Quadra 660av and 840av.  You 
can update software from the following internet address:  http://asu.info.apple.com/ 

ÂIf you are using a Macintosh that only has a USB port, you will have to purchase a "USB-to-
Serial" adapter.  This will allow your MTI-MAC cable to work with the computer. PRC has 
tested an adapter made by Keyspan.  Go to the Keyspan web page or do a computer search on 
"USB to Serial Adapters"��
 

ÂIf you want to put the vocabulary on floppy disks, have at least 2 or 3 formatted disks ready 
before you begin the transfer. 

ÂIf you have AppleTalk turned On, you must turn it Off (inactive) before you can do a 
memory transfer.  Make sure SerialKeys is turned Off. 

ÂOnce the transfer is in progress, do not plug anything into, or unplug anything from, the 
Vanguard. 
�

ÂWhen a transfer is in progress, periodically check the computer screen and Vanguard display 
for any messages or problems. 

ÂIf you experience a problem:  try changing the baud rate to 57600 in the MTI+ Preferences 
menu (inside the Edit menu).  You may have to change the port setting on your computer.  If 
you are not using a USB port, make sure the computer port you selected is the one your cable is 
plugged into, i.e., Modem or Printer.  If you are using the USB port, the Keyspan adapter 
requires you to set the port to Printer.  If you are using a different adapter, the information that 
came with the adapter should tell which computer port to set. 
 

ÂOn older Macintoshes you may have to:  turn the computer OFF.  Make your computer-to-
device connections.  Hold the computer Shift key down and turn the computer ON.  Continue to 
hold down the Shift key until you see, Welcome to Macintosh, All Extension Off.  Release the 
Shift key. 
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About Baud Rates 
 
When the Vanguard and a computer are connected, they send information to each other through 
their serial ports.  How fast the information travels from one serial port to the other is called the 
Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The important thing 
is that the baud rate for the MTI program and the baud rate for the Vanguard must be the 
same.   
 
The default baud rate for the Vanguard is 57600.  You can change the MTI baud rate to match 
the Vanguard or you change the Vanguard’s baud rate to match the MTI. 
 
 

To Change the MTI Baud Rate to Match the Vanguard: 
 

For the MTI+, click the Edit menu on the top of the computer display screen.  Click 
Preferences.  Click on the Baud Rate menu and select the rate you want. 
 
 
To Change the Vanguard’s Baud Rate to Match the MTI: 
 

Go to the Toolbox. 
 
Activate the TRANSFER MEMORY MENU. 
 
Activate the arrows in the "MTI Baud Rate" boxes until you see the baud rate you want to use. 
 
Activate OK. 
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Using the MTI+ for Macs 
 
1. All memory transfers should be made with the battery charger plugged in.  Plug the battery 

charger that came with your Vanguard into the CHARGER connector on the Vanguard.  Plug 
the other end into a wall outlet.   

 
2. All memory transfers should be made using the MTI+ cable that came with your MTI+, 

If you are using an older Mac, plug one end of the cable into either the Printer or Modem 
connector on the back of the computer.  Plug the other end into the connector that has the 
picture of a computer above it on the Vanguard.  If you are using a USB Mac, plug one end 
of the cable into the USB port on the computer.  Plug the adapter and the other end of the 
cable into the connector that has the picture of a computer above it on the Vanguard.   

 
3. Turn the computer On and insert the MTI CD.  Double-click on the MTI+ icon to open the 

program. 
 
4. Copy the MTI+ to your Hard Drive for Better Performance: 

 

Click and hold on the folder labeled MTI+.  Drag the folder to a location of your choice on 
your hard drive. 
 

Close any open programs or applications.  Then, double-click on the MTI+ folder on your 
hard drive to open the program.   
 

Making a Transfer 
 

5. Open the EDIT menu at the top of your computer screen and click on Preferences. 
 
6. Make sure Vanguard is selected in the Device menu. 
 
7. Set the baud rate to the rate you want to use.  The rate that is visible to begin with is the 

default baud rate for your selected device.  The MTI baud rate and the Vanguard baud rate 
must be the same. 

 
8. Select a computer port.  If you are using an older Mac, select the port you connected your 

cable to (either Printer or Modem).  If you are using a USB Mac, the instructions that came 
with your adapter should tell you which port to select.  The Keyspan adapter requires you to 
use the Printer port. 

 
9. Do not change any of the miscellaneous settings. 
 

10. Activate the  key on the front of the Vanguard case.  
 
11. Activate TRANSFER MEMORY MENU. 
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12. Activate "Save Entire Device Contents" or "Save One User Area" to start the saving 
procedure.   

�
ÂUse the "Load" option when you are loading vocabulary into your device.  Use "Merge" if 

you are adding new vocabulary to your current vocabulary.  
 
13. Type in the name of the file you want to use.  
�
Â To load memory, go to the correct drive (or disk) and double click on the file name you 

want.  Click on "Continue". 
 

ÂIf you experience a problem:  try changing the baud rate to 57600 in the MTI+ Preferences 
menu (inside the Edit menu).  You may have to change the port setting on your computer.  If 
you are not using a USB port, make sure the computer port you selected is the one your cable is 
plugged into, i.e., Modem or Printer.  If you are using the USB port, the Keyspan adapter 
requires you to set the port to Printer.  If you are using a different adapter, the information that 
came with the adapter should tell which computer port to set. 
 

ÂOn older Macintoshes you may have to:  turn the computer OFF.  Make your computer-to-
device connections.  Hold the computer Shift key down and turn the computer ON.  Continue to 
hold down the Shift key until you see, Welcome to Macintosh, All Extension Off.  Release the 
Shift key. 
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Transfer Vocabulary from One Vanguard to Another 
 
When you plug the MTI-Serial-VG-to-IBM-PC cable into the SERIAL PORT connector on the top 
of each Vanguard, you can transfer vocabulary from one Vanguard to another.  If you do not 
have the MTI-IBM cable, you can order it from PRC. 
 
To Transfer Vocabulary from One Vanguard to Another: 
 

1. Plug the MTI-Serial-VG-to-IBM-PC cable into the SERIAL PORT connector on the back of 
each Vanguard. (The ends of the cable are the same so it does not matter which end goes into 
which connector.) 

 
2. Go to the Toolbox. 
 
3. Activate the TRANSFER MEMORY Menu on each Vanguard.  (Make sure the baud rate is the 

same for both Vanguards in the OUTPUT MENU).   
 
4. On the Vanguard that contains the vocabulary you want to transfer, activate "SAVE ONE 

USER AREA" or "SAVE ENTIRE DEVICE CONTENTS" to begin the saving procedure. 
 
5. On the Vanguard that is going to receive the vocabulary, activate LOAD ONE USER AREA 

or "LOAD ENTIRE DEVICE CONTENTS" to start the loading procedure. 
 
6. The transfer takes place automatically.  
 

ÂIf you want to transfer specific Pages or Activities from one device to another, first load the 
Pages/Activities into a blank User Area in the device.  Then save and load that Area. 
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Importing Graphics to the Vanguard- Windows MTI Only 
 
If you have the Windows MTI, you can import almost any graphic to use in the Vanguard.  You 
can import photographs that you have scanned, clip art from various web sites, graphics you 
have drawn using a graphics program, etc.   
 
To import graphics, you need to remember two important rules: 

ÂGraphics must be in the BMP format. 

ÂGraphics must be in 256 colors. 
 
If the MTI will not import a graphic, open your graphics program, open the graphic you want to 
import and check the file format and number of colors for the graphic.  If the graphic is not listed 
as a BMP file in 256 colors, save it using the BMP format and 256 colors. 
 

ÂIf you do not have a graphics program on your computer, one is included on the MTI disk.  
This is a demonstration of Image Viewer/32™ and can only be used for a limited amount of time 
(30 days).   
 
An Example: 
Let’s say you have found a graphic on the web that you want to import to the Vanguard.   
 

14. Point to the graphic with your mouse and click on the right mouse button.   
 
2. Click on "Save as" in the menu that pops up. 
 
3. Select the drive and/or file where you want to save the graphic. 
 
4. If the graphic is not in "BMP" form, click on "BMP" in the "Save as type" box. (If "BMP" is 

not an option in your menu save the graphic as it is.) 
 
3. Change the title of the graphic if you want. 
 

ÂUse up to 8 characters to name a graphic.   

ÂDo not name your imported graphic with the same name as an original icon from the 
Vanguard default icons.  You will not be able to find your graphic once it is imported because 
the Vanguard will only acknowledge the original icon. 
 
6. Click on "Save". 
 
You can do one of two things now: 
 

ÂIf you saved the graphic as a "BMP" file: 
You can go ahead and open the MTI and try to import the graphic. See below for instructions.  If 
the graphic was not in 256 colors, the MTI will not let you import it.  
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ÂIf you could not save the graphic as a BMP file or if you have to check the colors: 
 

1. Open your graphics program.  Open the graphic that you just saved. 
15. Open the menu that allows you to select color depth.  In a graphics program like 

PaintShop Pro© this is the "Colors" menu.  In other programs it might be under a 
different menu. 

 
16. Set the color to 256.  In PaintShop Pro©, look at the "Increase Color Depth" and 

"Decrease Color Depth" options.  If "256" is highlighted in either option, select it.  If it 
isn’t highlighted in either menu, the graphic was originally done in 256 colors and will 
transfer.  

 
17. Go to the "File" menu and click on "Save as".   

 
5. Select the drive and/or file where you want to save the graphic. 
 
6. Select "BMP" from the "Save As Type" menu. 
 
7. Change the title of the graphic if you want. 
 
8. Click on "Save".   
 
 
To Install and Use Image Viewer/32: 
 

1. Put the MTI in the appropriate drive. 
 

2. In the computer Start menu, select Run. 
 

3. Type the drive you have the MTI in (e.g.," d: ") 
 

4. Type " ivsetup " (no spaces). 
Example:  a:  ivsetup 
 

5. See the installation screen on your computer. 
 

6. Choose:  
Next 
Agree 
Next 
Next 
Next 
Next 
Finish 
 

 

7. Activate OK.  Activate OK again. 
 

8. Go to the Start menu on your computer. 
Select Programs. 
Select Arcata Pet Software. 
Select IMGv3.2 Program File 
Select OK. 
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Open the program. 
 

9. Find the photo or icon you want to use. 
 

10. Select Open. 
 

11. You should see your picture. 
 

12. Open the Image menu in the menu bar. 
 

13. Select Convert To and choose 256 colors. 
 

14. Open the File menu in the menu bar. 
 

15. Select Save As. 
 

16. Select BMP and name the graphic. 
 

17. Select Save. 
 
 
To Import the Graphic to the Vanguard: 
 

1. All memory transfers should be made with the battery charger plugged in.  Connect one 
end of the battery charger that came with your Vanguard to the connector labeled CHARGER 
on the top of the Vanguard.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made with the VG-IBM cable, not the Vanguard’s infrared 

capability.  Plug one end of this cable into Serial Port 1 on your computer.  Plug the other 
end into the connector labeled SERIAL PORT on the top of the Vanguard. 

 
3. Turn the computer On.  If you have stored the MTI on your hard drive, double click on the 

MTI icon on your computer screen. Otherwise, insert the MTI CD into the appropriate drive 
of your computer.  Use "Windows Explorer" to go to the drive that contains the MTI CD or 
right click on "My Computer" then click on "Explore" to go to the drive that has the disk in 
it. 

 
4. Double click on the "MTI-EXE" icon.  The MTI screen is visible on your computer monitor. 
 
5. In the MTI "Options" menu, click on the device you are using (e.g., Vanguard). 
 
6. Go to the Vanguard’s Toolbox and open the TRANSFER MEMORY MENU. 
 
7. Activate "Import Icons".  If everything is connected correctly, you will see the "Select one or 

more bitmap files to load" menu on your computer screen. 
 
8. Go to the drive/open the folder where the graphic(s) you want to import is saved. 
 
9. Click on the graphic you want to import.  (If you want to import more than one graphic, hold 

down the CONTROL key and click on each graphic that you want to import.) 
 
10. Click on "Open".   
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11. If you want to change the name of the graphic, do it here.  If you want the graphic to have 
different proportions, remove the "check" from the box. 

12. Click "OK". 
 
13. The transfer takes place.  When it is finished, click on "OK".  
 
 
To Check that the Graphic Transferred: 
 

5. Go to the Vanguard Toolbox. 
 
2. Open the MODIFY PAGE MENU. 
 
3. Select any page, e.g., "Jokes". 
 
4. Activate an unused key. 
 
5. Activate "Change Icon". 
 
6. You see a new key, "IMPORTS" in the Icon Category menu.  Activate this key. 
 
7. The graphic you imported should be visible and ready for use. 
 
8. Activate "Cancel" to back your way out of the different MODIFY PAGE menus. 
 
9. If you have graphics that you no longer want in this menu, activate "Delete Icon" and select 

the icon to be deleted. 
 

ÂVanguard places all imported graphics under the IMPORTS key in the Icon Category menu.  
Activate MODIFY ACTIVITY or MODIFY PAGE to access this menu. 
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�Tips for a Successful Windows or DOS Memory 
Transfer 

 
 

�Plug the battery charger in before you begin a transfer. 
�

Â�Remove any previous versions of MTI software you may have on your computer before 
installing this MTI version. 

 

Â�Once the transfer is in progress, do not plug anything into, or unplug anything from, the 
AlphaTalker. 

�

Â�Digitized speech creates large vocabulary files.  Have 2 or 3 formatted disks ready to save 
your vocabulary on before you begin the transfer. 

 

Â�If you are using MTI-IBM-DOS with Windows, depending on the speed of your computer, 
the MTI may not run.  If this happens, restart your computer and use DOS mode to run the 
MTI, or use the MTI CD. 
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About Baud Rates  
 
When the AlphaTalker and a computer are connected, they send information to each other 
through their serial ports.  How fast the information travels from one serial port to the other is 
called the Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The 
important thing is that the baud rate for your computer (or MTI program) and the baud rate 
for the AlphaTalker must be the same.   
 
The default baud rate for the AlphaTalker is 57600.  You can change the MTI baud rate to match 
the AlphaTalker or you change the AlphaTalker’s baud rate to match the computer’s. 
 
 

To Change the MTI Baud Rate to Match the AlphaTalker: 
 
If you are using DOS, change the MTI program’s baud rate when you boot up the program.  Type 
"dosmti <space>the new baud rate<enter>".  For example:  C:/dosmti 9600 <ENTER>.   
 
If you are using Windows, change the baud rate in the MTI "Options" menu. 
 
 

To Change the AlphaTalker’s Baud Rate to Match the MTI: 
 

1. Remove the keyguard and overlay.  Press SELECT in the Control Panel and step to TOOLS.  
Press the ON/OFF side to turn the Toolbox On. 

 
2. Press SET BAUD RATE in the Toolbox.  All the LEDs in the Toolbox go out except the 

current baud rate.  This also flashes. 
 
3. Notice the numbers in the top right corners of keys C-4, D-4, E-4 and F-4.  Each of these 

numbers is a baud rate.  If you want the current baud rate (where the LED is lit) just activate 
that key.  If you want a different baud rate, activate the key with the number on it that you 
want.   

 
4. When you select a baud rate, that LED flashes for a few seconds.  When the light goes out, 

you can continue to use the Toolbox or you can go to the Control Panel and turn the Toolbox 
Off by pressing SELECT and then the ON/OFF side 
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Save Vocabulary Using the MTI for Windows® 

�
ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
start a transfer. 
 
 
Using the MTI: 
 

1. Remove the keyguard and overlay and open the Toolbox. 
 
2. All memory transfers should be made with the battery charger plugged in.  Connect one end 

of the battery charger that came with your AlphaTalker to the connector on the side of the 
case.  Plug the other end of the battery charger into a working wall outlet. 

 
3. Plug the larger rectangular end of the cable that came with your MTI program into Serial Port 

1 on your computer.  Plug the small round end into the connector labeled RS232 on the top 
of the AlphaTalker case.  

 
4. Turn the computer on.  Insert the MTI CD disk into the correct drive of your computer.  Use 

"Windows Explorer" or right click on "My Computer" and click on "Explore" to go to the 
drive that has the MTI CD in it.  

 
5. Double click on "MTI.exe".  The MTI screen is visible on your computer monitor. 
 
6. In the MTI "Options" menu, click on the name of the device you are using (i.e., 

’AlphaTalker’).  (You can also change computer serial ports here and select a baud rate if you 
need to.) 

 
7. To save memory to the computer:  Go to the AlphaTalker Toolbox and press the SAVE 

MEMORY TO DISK key.  If every thing is connected properly, you will see "Save Memory to 
File" on your computer screen.   

 
8. On your computer, go to the drive/folder where you want to save the AlphaTalker ’s memory. 
 
9. Type in a name for the new file (e.g., ATMEM1).  Click on "Save".  The transfer takes place 

automatically. 
 
 
To Restore Memory to the AlphaTalker: 
 

1. Select the LOAD MEMORY FROM DISK key in the AlphaTalker’s Toolbox. 
 
2. On your computer, select the AlphaTalker file you want to restore (e.g., ATMEM1). 
 
3. Click on "Restore". 
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Put the MTI CD on your hard drive and create a shortcut to it: 
 
1. Put the MTI CD disk in the correct drive of your computer. 
 
2. Use the "Windows Explorer" to go to the drive where you want to place the MTI CD. 
 
3. Create a new folder and label it " MTI". 
 
4. Go to the drive that contains the MTI CD disk. 
 
5. Right click on "MTI.exe". 
 
6. Left click on "Copy". 
 
7. Go to the drive where you created the MTI folder.  Right click on the folder. 
 
8. Left click on "Paste". 
 
9. Repeat these steps for the "MTI.hlp" file.  Add it to the new MTI folder. 

ÂInstead of using "Copy" and "Paste", you can move the original MTI CD files at once into the 
new MTI CD folder.  Click on one of the files on the MTI CD disk.  Then, hold down the 
<SHIFT> key and click on the other file.  Release the <SHIFT> key and drag the highlighted files 
to your new MTI folder. 
 
10. When the files have been moved to the new folder, double click on the new MTI folder. 
 
11. Right click on "MTI.exe". 
 
12. Left click on "Create Shortcut". 
 
13. The shortcut icon appears.  Click on it and drag it to your desktop. 
 
14. From now on you can open the MTI by double-clicking on this icon on your desktop.   
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MTI for DOS 
�
ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
start a transfer. 
 
 
Using the MTI 
 

1. Remove the keyguard and overlay from the AlphaTalker. 
 
2. All memory transfers should be made with the battery charger plugged in. Connect one end 

of the battery charger that came with your AlphaTalker to the connector labeled BATTERY 
CHARGER on the back of the AlphaTalker.  Plug the other end into a wall outlet.   

 
3. Plug the large end of the cable that came with your MTI program into Serial Port 1 on your 

computer.  Plug the small round end into the connector labeled RS-232 on the back of the 
AlphaTalker. 

 
4. Turn the computer On and insert the MTI CD into the appropriate drive.  Switch to the drive 

that has the disk in it if necessary. 
 
5. Type "DOSMTI.exe" and press <RETURN>. 
 
6. Type the letter of the device you are using: in this case type "A". 
 
7. Open the AlphaTalker’s Toolbox in the Control Panel by pressing OPTION SELECT. Step to 

TOOLS.  Press OPTION ON/OFF.   
 
8. In the Toolbox, press SAVE MEMORY or LOAD MEMORY.  Close the Toolbox by pressing 

OPTION SELECT and then OPTION ON/OFF.  The TOOLS light goes out.  
 
9. You are not allowed to save memory onto the MTI CD so choose a different disk or change 

to another drive to save memory to.  On the computer, type in the name of the file you want 
to save the memory to. 

 
9a. To load memory, select the file you want to load the memory from. 
 
10 Read the warning and then press F1 to continue. 
 

ÂNote:  If you experience a problem, you can change the MTI program’s baud rate when you 
boot up the program.  Type "dosmti <space>the new baud rate<enter>".  For example:  
C:/dosmti 9600 <ENTER>   Also, make sure you have the correct computer port selected. 
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�Tips for a Successful MAC+ Memory Transfer 
 

�Plug in the battery charger before you begin a memory transfer. 
� �
ÂThe MTI+ does not work well on the following Macs running a system software version that 
is older than 7.5.3:  Power Mac 6100, 7100 and 8100;  Centris/Quadra 660av and 840av.  You 
can update software from the following internet address:  http://asu.info.apple.com/ 
�
ÂIf you are using a Macintosh that only has a USB port, you will have to purchase a "USB-to-
Serial" adapter.  PRC has tested the adapter made by Keyspan.  Check the Keyspan web page or 
do a computer search for "USB to serial adapters". 
�
ÂIf you want to put the vocabulary on floppy disks, have at least 2 or 3 formatted disks ready 
before you begin the transfer. 
�

ÂIf you have AppleTalk turned On, you must turn it Off (inactive) before you can do a 
memory transfer. (Restart your computer.  As it restarts, hold the <SHIFT> key down to run off 
any extensions.)  Make sure SerialKeys is Off. 
�

ÂOnce the transfer is in progress, do not plug anything into, or unplug anything from, the 
AlphaTalker. 
�
ÂIf you experience a problem:  try changing the baud rate to 57600 in the MTI+ Preferences 
menu (inside the Edit menu).  You may have to change the port setting on your computer.  If 
you are not using a USB port, make sure the computer port you selected is the one your cable is 
plugged into, i.e., Modem or Printer.  If you are using the USB port, the Keyspan adapter 
requires you to set the port to Printer.  If you are using a different adapter, the information that 
came with the adapter should tell which computer port to set. 
 

ÂOn older Macintoshes you may have to:  turn the computer OFF.  Make your computer-to-
device connections.  Hold the computer Shift key down and turn the computer ON.  Continue to 
hold down the Shift key until you see, Welcome to Macintosh, All Extension Off.  Release the 
Shift key. 
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About Baud Rates 
 
When the AlphaTalker and a computer are connected, they send information to each other 
through their serial ports.  How fast the information travels from one serial port to the other is 
called the Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The 
important thing is that the baud rate for your computer (or MTI program) and the baud rate 
for the AlphaTalker must be the same.   
 
The default baud rate for the AlphaTalker is 57600.  You can change the MTI+ baud rate to 
match the AlphaTalker or you can change the AlphaTalker’s baud rate to match the MTI+ 
program. 
 
To Change the MTI+ Baud Rate to Match the AlphaTalker: 
 

For the MTI+, click the Edit menu on the top of the computer display screen.  Click 
Preferences.  Click on the Baud Rate menu and select the rate you want. 
 
 
To Change the AlphaTalker’s Baud Rate to Match the MTI+: 
 

1. Remove the keyguard and overlay.  Press SELECT in the Control Panel and step to TOOLS.  
Press the ON/OFF side to turn the Toolbox On. 

 
2. Press SET BAUD RATE in the Toolbox.  All the LEDs in the Toolbox go out except the 

current baud rate.  This also flashes. 
 
3. Notice the numbers in the top right corners of keys C-4, D-4, E-4 and F-4.  Each of these 

numbers is a baud rate.  If you want the current baud rate (where the LED is lit) just activate 
that key.  If you want a different baud rate, activate the key with the number on it that you 
want.   

 
4. When you select a baud rate, the LED flashes for a few seconds.  When the light goes out, 

you can continue to use the Toolbox or you can go to the Control Panel and turn the Toolbox 
Off by pressing SELECT and then the ON/OFF side 
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Using the MTI+ for Macs 
 
1. All memory transfers should be made with the battery charger plugged in.  Plug the battery 

charger that came with your Pathfinder into the CHARGER connector on the side of the 
Pathfinder.  Plug the other end into a wall outlet.   

 
2. All memory transfers should be made using the cable that came with your MTI+.  If you are 

using an older Mac, plug one end of the cable into the connector on the back of the computer 
that has the picture of the telephone handset above it or the picture of the printer. Plug the 
other end into the RS232 connector on the back of the AlphaTalker. If you are using a USB 
Mac, plug the cable into the USB port.  Plug the adapter and other end of the cable into the 
RS232 port on the AlphaTalker.   

 
3. Turn the computer On and insert the MTI CD.  Double-click on the icon to open the 

program. 
 
4. Copy the MTI+ to your Hard Drive for Better Performance: 

 

Click and hold on the folder labeled MTI+.  Drag the folder to a location of your choice on 
your hard drive. 
 

Close any open programs or applications.  Then, double-click on the MTI+ folder on your 
hard drive to open the program.   

 
Making a Transfer 
5. Open the EDIT menu at the top of your computer screen and click on Preferences. 
 
6. Make sure AlphaTalker is selected in the Device menu. 
 
7. Set the baud rate to the rate you want to use.  The rate that is visible to begin with is the 

default baud rate for your selected device.  This baud rate must be the same as the baud rate 
in the AlphaTalker. 

 
8. Select a Computer Port:  If you are using an older Mac, select the computer port you 

plugged your cable into, either Printer or Modem.  If you are using a USB Mac, select the 
computer port that your adapter instructions tell you to use.  If you are using a Keyspan 
adapter, you must select the Printer port. 

 
9. Do not change any of the Miscellaneous settings. 
 
10. Open the AlphaTalker’s Toolbox in the Control Panel.   
 
11. In the Toolbox, press SAVE MEMORY or LOAD MEMORY.   

 

To Save Memory:  select the disk or drive where you want to save the memory.  Type in 
the file name you want to use.  Close the Toolbox. 
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To Load Memory:  Go to the correct disk or drive where you saved the memory. Double 
click on the name of the file you want to load.  

 
ÂUse the "Load" option when you are loading vocabulary into your device.  Use "Merge" if 
you are adding new vocabulary to your current vocabulary.  
 

ÂIf you experience a problem:  try changing the baud rate to 57600 in the MTI+ Preferences 
menu (inside the Edit menu).  You may have to change the port setting on your computer.  If 
you are not using a USB port, make sure the computer port you selected is the one your cable is 
plugged into, i.e., Modem or Printer.  If you are using the USB port, the Keyspan adapter 
requires you to set the port to Printer.  If you are using a different adapter, the information that 
came with the adapter should tell which computer port to set. 
 

ÂOn older Macintoshes you may have to:  turn the computer OFF.  Make your computer-to-
device connections.  Hold the computer Shift key down and turn the computer ON.  Continue to 
hold down the Shift key until you see, Welcome to Macintosh, All Extension Off.  Release the 
Shift key. 
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Transfer Vocabulary from One AlphaTalker to Another 
 
By plugging the MTI+ (Macintosh) cable in to the RS-232 ports on the top of each AlphaTalker, 
you can transfer vocabulary (not system information) from one AlphaTalker to another.  If you 
do not have the MTI+ cable, you can order it from PRC. 
 
 
Using the MTI: 
 
1. Plug the MTI+ cable into the RS-232 connectors on the top panel of each AlphaTalker. (The 

ends of the cable are the same so it doesn’t matter which end goes into which connector.) 
 
2. Remove the keyguard and overlay from each AlphaTalker.  Go to the Control Panel on each 

AlphaTalker.  Step to TOOLS, then activate OPTION ON/OFF to open the Toolbox.   
 
3. Activate SAVE MEMORY in the Toolbox of the AlphaTalker that has the vocabulary you 

want to transfer.  
 
4. Activate LOAD MEMORY in the Toolbox of the AlphaTalker you want to load the saved 

memory into. 
 
5. The transfer takes place automatically.  Lights will blink on the AlphaTalker that is 

transferring its memory.  When the transfer is finished the lights will stop blinking. 
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AlphaTalker Keyboard Emulation  
 
Keyboard emulation allows you to set up the AlphaTalker keyboard so that if functions like a 
computer keyboard and therefore allows you to use a computer.  It also lets you use the 
AlphaTalker to run environmental control units (ECU’s) like the Director or the Control-1.  You 
must have the MTI software and a keyboard emulator like the T-TAM or and ECU in order to 
use Keyboard Emulation.  Once you have created an overlay you will not have to use the MTI 
unless you want to go back and modify the original overlay or create a new one. 
 

ÂIf you have an Apple computer you have to create the emulation overlay on a Macintosh or 
IBM computer.  Once the overlay is created, you can load it into the AlphaTalker and connect 
the T-TAM, the Apple and the AlphaTalker and use the emulation overlay. 
 

ÂWhen you are using Keyboard emulation you cannot store or speak messages.  You must 
turn the Keyboard Emulation tool Off in order to use the AlphaTalker for speaking. 
 

ÂBefore you begin to create an emulation overlay, know what the computer (or ECU) 
commands are that you want to put on the overlay.  See Appendix A for a list of 
Apple/Macintosh and IBM computer key commands. 
 

ÂSave the vocabulary in the AlphaTalker before you begin. 
 

ÂMake sure the baud rates between the AlphaTalker and the emulation program are the 
same. 
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�Tips for a Successful Emulation Transfer 

 

ÂAlways save the AlphaTalker’s vocabulary first. 
 

ÂOnce you save the emulation overlay, you must load it into the AlphaTalker.  Use the MTI. 
 

ÂWhen you are ready to use the emulation overlay, set the AlphaTalker’s baud rate to the same 
rate that your emulator uses. 
 

ÂIf you are using a Macintosh that only has a USB port, you will have to purchase a "USB-to-
Serial" adapter.  This will allow your MTI-MAC cable to work with the computer. 
 

ÂAbout Entering Emulation Commands: 
You must type the overlay commands in the language that your keyboard emulator or ECU 
understands.  For example,  all keyboard emulator manuals tell you that to program an "UP" key, 
you must press the ESCAPE key on the computer, type UP and then type a period(.).  
 
The DIRECTOR manual tells you that you must start each command with NULL ESC  (NULL is 
represented by activating the CRTL and @ keys:  CTRL@ESC)and then continue with specific 
instructions until you end with a period.  (On those Macintosh’s which do not have a Control key 
you must use the Command key.  
 
For more information about entering commands correctly, read the manual that came with your 

emulator or ECU.  ÂSee Appendix A in this manual for a list of computer key commands that 
can be used for emulation. 
 

Â8 and 4 Location Emulation Overlays: 
With an 8 or 4 Location emulation overlay, you must program your instructions into the upper 
left corner key in each block of keys. 
 

ÂWhen you are using keyboard emulation you cannot speak or store messages.  You must turn 
KEYBOARD EMULATION Off in the Toolbox before you can speak or store.  You can assign the 
KEYBOARD EMULATION tool to a key on your overlay if you would like to have it handy.  
 

ÂRemember:  if you assign KEYBOARD EMULATION to a key, you cannot assign an emulation 
command to that key when you are creating your emulation. 
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Keyboard Emulation-IBM 

 
Remove the keyguard and overlay. Use the MTI program, to save the AlphaTalker’s 
vocabulary first (see the MTI-IBM Instructions) then: 
 
1. Press F9 on the computer keyboard (DOS, 3.1) or select Keyboard Emulation (Windows). 
 
2. Select the file you want to use for emulation (we suggest you use the just saved vocabulary 

file).  
 
3. Create the emulation overlay.  Select squares on the computer screen by pressing the arrow 

keys on the computer keyboard.  Type the directions you want the key to contain. You may 
type up to 63 characters per key, but only a few of them will show on the overlay squares.  

 
4. When you have finished, you can exit the program without saving the emulation (practice) or 

you can save the emulation by pressing F5. 
 
5. Load the saved emulation back into the AlphaTalker. Turn the Toolbox On.  Activate 

LOAD MEMORY (F4) and follow the directions on your computer screen. 
 
6. When the file is loaded, exit the MTI program, disconnect the MTI cable and connect your 

keyboard emulator or ECU to the AlphaTalker and the computer (see the emulator manual).   
 
7. Turn the Toolbox On in the Control Panel.  Activate BAUD RATE in the Toolbox and then 

the baud rate that your emulator uses (usually 300 or 1200).  Turn KEYBOARD 
EMULATION (D4) ON.  Make sure the program you want to use is running on your computer or 
in the case of an ECU, that the ECU is turned On.  

 

ÂWith an 8 or 4 location emulation overlay you must program instructions into the upper left 
corner key in each block of keys. 
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Keyboard Emulation—Macintosh 
 

Remove the keyguard and overlay. Boot up the MTI+ program.  Always save the AlphaTalker 
vocabulary first (see the MTI+ instructions earlier in this chapter).  
 
1. Click on "AT Keyboard Emulation" in the Tools menu at the top of the program. 
 
2. Click on the file you want to use (use the vocabulary file you just saved). 
 
3. Select keys on the computer screen by clicking on them.  Type the directions you want the 

key to contain.  You may type up to 63 characters per key, but only a few of them will show 
on the overlay squares.   

ÂHEPFUL HINT:  The pop-up menu on the left of the MTI+ emulation screen gives you 
various computer control characters.  You can select the ESC character from the list and then 
type in the command you want to use.  This saves you from activating CTRL[ before every 
command. 

 
4. When you have finished, you can exit the program without saving the emulation ("Cancel") 

or you can save the emulation by clicking on "Save". 
 
5. Once you save the emulation, load it back into the AlphaTalker. Turn the Toolbox On.  

Activate LOAD MEMORY (F4) and follow the directions on your computer screen. 
 
6. When the file is loaded, exit the MTI+ program, disconnect the MTI+ cable and connect your 

keyboard emulator or ECU to the AlphaTalker and the computer (see the emulator manual).   
 
7. Turn the Toolbox On in the Control Panel.  Activate BAUD RATE (C4) in the Toolbox and 

then the baud rate that your emulator uses (usually 300 or 1200).  Turn KEYBOARD 
EMULATION (D4) ON.  Make sure the program you want to use is running on your computer 
or in the case of an ECU, that the ECU is turned On. 

 

ÂWith an 8 or 4 location emulation overlay you must program instructions into the upper left 
corner key in each block of keys. 
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Copy the ASSIGN KEYBOARD EMULATION Key from the 
Toolbox to Your Overlay 
 
If you would like to have the KEYBOARD EMULATION tool on your regular AlphaTalker overlay, 
you can copy the ASSIGN KEYBOARD EMULATION key (G4) from the Toolbox to your overlay.  
Once this key is copied on your overlay, you use it the same way you use the KEYBOARD 
EMULATION tool in the Toolbox.  That is, you just activate the key on your overlay where you 
copied ASSIGN KEYBOARD EMULATION to put the AlphaTalker into keyboard emulation.  To exit 
keyboard emulation you just activate the key again.   
 
When you copy a key from the Toolbox to your overlay you can still use the key in the Toolbox 
if you want, as well as the key on your overlay. 
 
To Copy the ASSIGN KEYBOARD EMULATION Key to Your Overlay: 
 
1. Press SELECT in the Control Panel and step to TOOLS.  Press the ON/OFF side to open the 

Toolbox. 
 
2. Press STORE in the Control Panel. 
 
3. The three keys in the Toolbox that you can copy to your overlay light up.  Press the ASSIGN 

KEYBOARD EMULATION key. 
 
4. Press the key on your overlay where you want to put ASSIGN KEYBOARD EMULATION. (Icon 

Prediction allows you to see where you have blank keys.  No LEDs will be lit at the blank 
keys.) 

 
5. You hear three quick beeps.  This tells you that the keyboard emulation key has been copied 

onto your overlay. 
 
6. Turn the Toolbox Off in the Control Panel. (Press SELECT.  When the TOOLS light flashes, 

press the ON/OFF side.) 
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�Tips for a Successful Windows or DOS Memory 
Transfer 

�
�

�Plug the battery charger in before you begin a transfer. 
�

�If you have the infrared software up and running on your DeltaTalker: 
 DO NOT attempt a memory transfer by using the infrared capability.  Use the MTI cable 

that is supplied with your MTI CD and connect your DeltaTalker and computer with the 
cable. 

  

Â�If you are going to save vocabulary to an IBM disk, have at least 2 or 3 formatted disks 
ready before you begin the transfer. 

 

Â�The following is an especially important hint! 
 If you are going to download vocabulary that was programmed for an 8 or 32 location 

overlay, make sure you are currently using the 8 or 32 set-up in the DeltaTalker.  If you 
aren’t, you must open the CHANGE OVERLAY menu and switch to the 8 or 32 keyboard and 
overlay before you download the vocabulary. 

 

Â�If you are using DOS with Windows, depending on the speed of your computer, the MTI 
may not run.  If this happens, restart your computer and use DOS mode to run the MTI, or 
use the MTI CD. 

 

Â�Once the transfer is in progress, do not plug anything into, or unplug anything from, the 
DeltaTalker. 

 

Â�When a transfer is in progress, periodically check the computer screen and DeltaTalker 
display for any messages or problems. 
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About Baud Rates 
 
When the DeltaTalker and a computer are connected, they send information to each other 
through their serial ports.  How fast the information travels from one serial port to the other is 
called the Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The 
important thing is that the baud rate for your computer (or MTI program) and the baud rate 
for the DeltaTalker must be the same.   
 
The default baud rate for the DeltaTalker is 57600.  You can change the MTI baud rate to match 
the DeltaTalker or you change the DeltaTalker’s baud rate to match the computer’s. 
 
 
To Change the MTI Baud Rate to Match the DeltaTalker: 
 
If you are using DOS, change the MTI program’s baud rate when you boot up the program.  Type 
"dosmti <space>the new baud rate<enter>".  For example:  C:/dosmti 9600 <ENTER>.   
 
If you are using Windows, change the baud rate in the MTI "Options" menu. 
 
 
To Change the DeltaTalker’s Baud Rate to Match the MTI: 
 

1. Turn the Toolbox On. 
 
2. Activate the TRANSF. MEMORY menu. 
 
3. Activate NEXT MENU ITEM to step to "MTI Baud Rate = >57600<. 
 
4. Activate CHANGE >ITEM< until you step to the baud rate you want to use. 
 
5. Activate EXIT. 
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Save Vocabulary Using the MTI for Windows®  
 

ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
start a transfer. 
 
 
Using the MTI CD: 
 
1. Remove the keyguard and overlay and open the Toolbox. 
 

2. All memory transfers should be made with the battery charger plugged in.  Connect one end 
of the battery charger that came with your DeltaTalker to the connector on the top of the 
case.  Plug the other end of the battery charger into a working wall outlet. 

 

3. Plug the larger rectangular end of the cable that came with your MTI program into Serial Port 
1 on your computer.  Plug the small round end into the RS232 connector on the top of the 
DeltaTalker case.  

 

4. Turn the computer on.  Insert the MTI CD disk into the appropriate drive.  Use "Windows 
Explorer" or right click on "My Computer" and click on "Explore" to go to the drive that has 
the MTI CD in it.  

 

5. Double click on "MTI.exe".  The MTI screen is visible on your computer monitor. 
 

6. In the MTI "Options" menu, click on the name of the device you are using (i.e., 
’DeltaTalker’).  You can also change computer serial ports here and select a baud rate if you 
need to. 

 

7. To save memory to the computer:  Go to the DeltaTalker Toolbox.  Activate TRANSFER 
MEMORY MENU.  Activate NEXT MENU ITEM until you see SAVE MEMORY TO DISK.  Activate 
CHANGE >ITEM<.  If every thing is connected properly, you will see "Save Memory to File" 
on your computer screen.   

 

8. On your computer, go to the drive/folder where you want to save the DeltaTalker’s memory. 
 

9. Type in a name for the new file (e.g., DTMEM701).  Click on "Save".  The transfer takes place 
automatically. 

 
 

To Restore Memory to the DeltaTalker: 
 

3. Select the LOAD MEMORY FROM DISK from the TRANSFER MEMORY MENU in the DeltaTalker 
Toolbox. 

 

4. On your computer, select the DeltaTalker file you want to restore (e.g., DTMEM701). 
 

5. Click on "Restore". 
 



 

DELTATALKER 
MTI MANUAL 

108 

Put the MTI CD on your hard drive and create a shortcut to it: 
 
1. Make sure the MTI CD is in the correct drive of your computer. 
 
2. Using the "Windows Explorer", go to the drive where you want to place the MTI CD. 
 
3. Create a new folder and label it, " MTI". 
 
4. Go to the drive that contains the MTI CD disk. 
 
5. Right click on "MTI.exe". 
 
6. Left click on "Copy". 
 
7. Go to the drive where you created the "MTI" folder.  Right click on the folder. 
 
8. Left click on "Paste". 
 
9. Repeat these steps for "MTI.hlp" file.  Add it to the new "MTI" folder. 
 

ÂInstead of using "Copy" and "Paste", you can move the MTI CD files at once into the new 
"MTI" folder.  Click on one of the files on the MTI CD disk.  Then, hold down the <SHIFT> key 
and click on the other file.  Release the <SHIFT> key and drag the highlighted files to your new 
"MTI" folder. 
 
10. When the files have been moved to the new folder, double click on the new "MTI"folder. 
 
11. Right click on "MTI.exe". 
 
12. Left click on "Create Shortcut". 
 
13. The shortcut icon appears.  Click on it and drag it to your desktop. 
 
14. From now on you can open the MTI by double-clicking on this icon on your desktop.   
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MTI for DOS 
 
 
 
 

 

ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
start a transfer. 
 
 

To Transfer Memory: 
 

1. Remove the keyguard and overlay from the DeltaTalker. 
 
2. All memory transfers should be made with the battery charger plugged in.  All memory 

transfers should be made with the cable, not the DeltaTalker infrared capability.  Connect one 
end of the battery charger that came with your DeltaTalker to the connector labeled BATTERY 
CHARGER on the back of the DeltaTalker.  Plug the other end into a wall outlet.   

 
3. Plug the large end of the cable that came with your MTI program into Serial Port 1 on your 

computer.  Plug the small round end into the connector labeled RS-232 on the back of the 
DeltaTalker. 

 
4. Turn the computer On and insert the MTI CD disk into the appropriate drive.  Switch to the 

drive that has the disk in it if necessary. 
 
5. Type "DOSMTI.exe" and press <RETURN>. 
 
6. Type the letter of the device you are using: in this case type "E". 
 
7. Turn on the DeltaTalker’s Toolbox.   
 
8. Activate the TRANSF. MEMORY menu in the Toolbox. 
 
9. Activate NEXT MENU ITEM to step through the menu until  
 Save Memory to Disk = >NO< is on the display. Activate CHANGE >ITEM< to start the saving 

process.   
 Use "Load Memory from Disk = >NO<" when you are loading a vocabulary into your 

DeltaTalker. Use "Merge = >NO<" when you are downloading a MAPMate. 
 
10. On the computer, type in the name of the file you want to save the memory to.  Press F1 to 

complete the transfer. 
 
10a.To load memory, select the file on the computer that you want to load the memory from. 
 

ÂIf you experience a problem, you can change the MTI program’s baud rate when you boot up 
the program.  Type:  dosmti<space>the new baud rate<enter>,  For example, 
C:/dosmti9600<ENTER> 
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�Tips for a Successful MTI+ Memory Transfer 
(Macintosh) 
 

�Plug in the battery charger before you begin a memory transfer. 

�DO NOT attempt a memory transfer by using the infrared capability.  Use the cable that 
came with your MTI+ disk and connect your DeltaTalker and computer with the cable. 

ÂThe MTI+ does not work well on the following Macs running a system software version that 
is older than 7.5.3:  Power Mac 6100, 7100 and 8100;  Centris/Quadra 660av and 840av.  You 
can update software from the following internet address:  http://asu.info.apple.com/ 

Â�The following is an especially important hint! 
If you are going to download vocabulary that was programmed for an 8 or 32 location overlay, 
make sure you are currently using the 8 or 32 set-up in the DeltaTalker.  If you aren’t, you must 
open the CHANGE OVERLAY menu and switch to the 8 or 32 keyboard and overlay before you 
download the vocabulary. 
 

ÂIf you are using a Macintosh that only has a USB port, you will have to purchase a "USB-to-
Serial" adapter.  PRC has tested an adapter made by Keyspan.  Check the Keyspan web page or 
do a computer search for "USB to Serial Adapeter".   

ÂIf you want to put the vocabulary on floppy disks, have at least 2 or 3 formatted disks ready 
before you begin the transfer. 
 

ÂAppleTalk must be turned Off (inactive).  SerialKeys must be turned Off. 
 

ÂOnce the transfer is in progress, do not plug anything into, or unplug anything from, the 
DeltaTalker. 
 

ÂWhen a transfer is in progress, periodically check the computer screen and DeltaTalker 
display for any messages or problems. 
 

ÂIf you experience a problem:  try changing the baud rate to 57600 in the MTI+ Preferences 
menu (inside the Edit menu).  You may have to change the port setting.  If you are not using a 
USB port, set the port setting to match the port your cable is in (i.e., Printer or Modem).  If you 
are using a USB port, set the port recommended in the adapter instructions.  The Keyspan 
adapter requires the Printer port. 
 

ÂOn older Macintoshes you may have to:  turn the computer OFF.  Make your computer-to-
device connections.  Hold the computer Shift key down and turn the computer ON.  Continue to 
hold down the Shift key until you see, Welcome to Macintosh, All Extension Off.  Release the 
Shift key. 
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About Baud Rates 
 
When the DeltaTalker and a computer are connected, they send information to each other 
through their serial ports.  How fast the information travels from one serial port to the other is 
called the Baud Rate.  The baud rate can be slow (300) or it can be very fast (57600).  The 
important thing is that the baud rate for your computer (or MTI program) and the baud rate 
for the DeltaTalker must be the same.   
 
The default baud rate for the DeltaTalker is 57600.  You can change the MTI baud rate to match 
the DeltaTalker or you change the DeltaTalker’s baud rate to match the computer’s. 
 
 

To Change the MTI Baud Rate to Match the DeltaTalker: 
For the MTI+, click the Edit menu on the top of the computer display screen.  Click 
Preferences.  Click on the Baud Rate menu and select the rate you want. 
 
 
To Change the DeltaTalker’s Baud Rate to Match the MTI: 
 

Turn the Toolbox On. 
 
Activate the TRANSF. MEMORY menu. 
 
Activate NEXT MENU ITEM to step to "MTI Baud Rate = >57600<. 
 
Activate CHANGE >ITEM< until you step to the baud rate you want to use. 
 
Activate EXIT. 
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Using the MTI+ for Macs 
 
1. All memory transfers should be made with the battery charger plugged in.  Plug the battery 

charger that came with your DeltaTalker into the CHARGER connector on the DeltaTalker.  
Plug the other end into a wall outlet.   

 
2. All memory transfers should be made using the MTI+ cable that came with your MTI+, not 

the DeltaTalker’s infrared capability.  If you are using an older Mac, plug one end of the 
cable into the connector on the back of the computer that has the picture of the telephone 
handset or the printer above it. Plug the other end into RS232 connector on the DeltaTalker.  
If you are using a USB Mac, plug the cable into the USB port.  Plug the adapter and other 
end of the cable into the RS232 connector on the DeltaTalker.   

 
3. Turn the computer On and insert the MTI CD.  Double-click on the icon to open the 

program. 
 
4. Copy the MTI+ to your Hard Drive for Better Performance: 

 

Click and hold on the folder labeled MTI+.  Drag the folder to a location of your choice on 
your hard drive. 
 

Close any open programs or applications.  Then, double-click on the MTI+ folder on your 
hard drive to open the program.   
 

Making a Transfer: 
5. Open the EDIT menu at the top of your computer screen and click on Preferences. 
 
6. Make sure DeltaTalker is selected in the Device menu. 
 
7. Set the baud rate to the rate you want to use.  The rate that is visible to begin with is the 

default baud rate for your selected device.  This baud rate and the DeltaTalker baud rate 
must be the same. 

 
8. Select a computer port settings.  If you are using an older Mac, select the port you connected 

your cable to (either Printer or Modem).  If you are using a USB Mac, the instructions that 
came with your adapter should tell you which port to select.  The Keyspan adapter requires 
you to use the Printer port. 

 
9. Do not change any of the Miscellaneous settings. 
 
10. Open the DeltaTalker Toolbox. 
 
11. Activate TRANSFER MEMORY MENU. 
 
12. Activate NEXT MENU ITEM to step until Save Memory to Disk = >NO< is on the display. 

Activate CHANGE >ITEM< to start the saving procedure.   
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ÂUse the "Load" option when you are loading vocabulary into your device.  Use "Merge" if 
you are adding new vocabulary to your current vocabulary.  

 
13. Type in the name of the file you want to use.  
�
Â To load memory, go to the correct drive (or disk) and double click on the file name you 

want.  Click on "Continue". 
 
 

ÂIf you experience a problem:  try changing the baud rate for the computer to 57600 in the 
MTI+ Baud Rate menu under Preferences in the Edit menu on the menu bar.  Remember, the 
baud rate for the DeltaTalker and the computer must be the same.  Check that that you have 
selected the correct computer port.  If you are using an older Mac, select the port that you 
plugged your cable into (Modem or Printer).  If you are using a USB Mac, you must select the 
port that is indicated in your adapter instruction.  The Keyspan adapter requires that you select 
the Printer port. 
 

ÂOn older Macintoshes you may have to:  turn the computer OFF.  Make your computer-to-
device connections.  Hold the computer Shift key down and turn the computer ON.  Continue to 
hold down the Shift key until you see, Welcome to Macintosh, All Extension Off.  Release the 
Shift key. 
 



 

DELTATALKER 
MTI MANUAL 

115 

Transfer Vocabulary from One DeltaTalker to Another 
 

ÂRead the "Tips for a Successful Memory Transfer" at the beginning of this chapter before you 
start a transfer. 
 
By plugging the MTI+ cable in to the RS-232 ports on the back of each DeltaTalker, you can 
transfer vocabulary from one DeltaTalker to another.  If you do not have the MTI+ cable, you 
can order it from PRC. 
 
 
To Transfer Vocabulary from One DeltaTalker to Another: 
 
1. Plug the MTI cable into the RS-232 connectors on the top of each DeltaTalker. (The ends of 

the cable are the same so it doesn’t matter which end goes into which connector.) 
 

2. Remove the keyguard and overlay from each DeltaTalker. Turn the Toolbox On in each 
DeltaTalker. 

 

3. Activate TRANSFER MEMORY on the DeltaTalker that has the vocabulary you want to 
transfer. Activate NEXT MENU ITEM to step to Baud Rate.  Make sure the baud rate is the 
same for both DeltaTalkers.   

 

4. Activate NEXT MENU ITEM to step to:  SAVE TO DISK = >NO<. 
 

5. Activate CHANGE >ITEM< to begin the saving procedure.  You see, "Looking for host 
computer...." 

 

6. On the DeltaTalker you want to put the memory into activate NEXT MENU ITEM to step to 
Baud Rate.   Make sure the baud rate is the same for both DeltaTalkers.   

 

7. Activate NEXT MENU ITEM to step to LOAD MEMORY FROM DISK = >NO<.  
 

8. Activate CHANGE >ITEM< to start the loading procedure. 
 

9. The transfer takes place automatically. 
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Appendix A:  Computer Commands for Keyboard 
Emulation 
 
Use the following commands when you are doing keyboard emulation for IBM Keyboards 
and Keypads 
 
Create the <esc> command that you see below by activating   CTRL[  ( Control left bracket ) in 
your Toolbox.  This sequence is shown as <esc> in all commands below.  On your display you 
will see a small left arrow. 
 
 
IBM Keyboard Keys 
<esc>backspace. 
<esc>capslock. 
<esc>delete. 
<esc>down. 
<esc>end. 
<esc>enter. 
<esc>esc. 
<esc>f1. 
<esc>f2. 
<esc>f3. 
<esc>f4. 

<esc>f5. 
<esc>f6. 
<esc>f7. 
<esc>f8. 
<esc>f9. 
<esc>f10. 
<esc>f11. 
<esc>f12. 
<esc>home. 
<esc>insert. 
<esc>left. 

<esc>pagedown. 
<esc>pageup. 
<esc>pause. 
<esc>print. 
<esc>right. 
<esc>scroll. 
<esc>tab. 
<esc>up. 
<esc>,hold,alt. 
<esc>,hold,control. 
<esc>,hold,shift. 

 
Specify a right or left key by placing and "r" or an "l" in front of the key name.  For example, 
 
To hold the left shift key: <esc>,hold,lshift. 
 
 
IBM Keypad Keys 
 
<esc>kp0. 
<esc>kp1. 
<esc>kp2. 
<esc>kp3. 
<esc>kp4. 
<esc>kp5. 
<esc>kp6. 
<esc>kp7. 
<esc>kp8. 
<esc>kp9. 
<esc>kpdel. 
<esc>kpdown. 
<esc>kpend. 
<esc>kpenter. 

 
 
 
<esc>kphome. 
<esc>kpins. 
<esc>kpleft. 
<esc>kpminus. 
<esc>kppgdn. 
<esc>kpplus. 
<esc>kpright. 
<esc>kpslash. 
<esc>kpstar. 
<esc>kpup. 
<esc>kpnumlock. 
<esc>sysreq. 
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Computer Commands For Apple/Macintosh Computer Keyboards and 
Keypads 
 
Create the <esc> command that you see below by activating   CTRL[  ( Control left bracket ) in 
your Toolbox.  This sequence is shown as <esc> in all commands below.  On your display you 
will see a small left arrow. 
 

ÂIf you are using an AlphaTalker, you can select <esc> from the MTI+ emulation menu. 
 
Apple/Macintosh Keyboard Keys 
<esc>backspace. 
<esc>capslock. 
<esc>delete. 
<esc>end. 
<esc>esc. 
<esc>f1. 
<esc>f2. 
<esc>f3. 
<esc>f4. 
<esc>f5. 
<esc>f6. 
<esc>f7. 
<esc>f8. 

<esc>f9. 
<esc>f10. 
<esc>f11. 
<esc>f12. 
<esc>f13. 
<esc>f14. 
<esc>f‘15. 
<esc>help. 
<esc>home. 
<esc>insert. 
<esc>left. 
<esc>pagedown. 
<esc>pageup. 

<esc>pause. 
<esc>print. 
<esc>return. 
<esc>right. 
<esc>scroll. 
<esc>tab. 
<esc>up. 
<esc>,hold,command. 
<esc>,hold,control. 
<esc>,hold,option. 
<esc>,hold,shift. 
<esc>,hold,alt. 

 
Specify a right or left key by placing an "r" or an "l" in front of the key name.  For example, 
 
To hold the left shift key:  <esc>,hold,lshift. 
 
 
Apple/Macintosh Keypad Keys 
 
<esc>kp0. 
<esc>kp1. 
<esc>kp2. 
<esc>kp3. 
<esc>kp4. 
<esc>kp5. 
<esc>kp6. 
<esc>kp7. 
<esc>kp8. 
<esc>kp9. 
<esc>clear. 
<esc>kpdel. 
<esc>kpdown. 
<esc>kpend. 

<esc>kpenter. 
<esc>kpequal. 
<esc>kphome. 
<esc>kpins. 
<esc>kpleft. 
<esc>kpminus. 
<esc>kppd. 
<esc>kppgdn. 
<esc>kppgup. 
<esc>kpplus. 
<esc>kpright. 
<esc>kpslash. 
<esc>kpstar. 
<esc>kpup. 

<esc>numlock. 
<esc>reset. 
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Appendix B:  Troubleshooting 
 
 

ÂYou have checked your saved or loaded vocabulary and all the information does not 
seem to be there. 
 

Slow down the baud rate and try again.  This is especially helpful for older computers. 
 

ÂYou are trying to save a large file to a number of floppy disks and you get error 
messages. 
 

Save the file to the hard drive on your computer instead of floppies. 
 

ÂA transfer does not take place: 
Check the baud rates.  The MTI and communication device baud rates must be the same. 
If you are using a Macintosh computer: You may have to change the port setting.  If you are 
not using a USB port, set the port setting to match the port your cable is in (Modem or Printer).  
The Keyspan adapter requires the port to be set to Printer to work. 
 
 
 
 


